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Chapter 1 

Introduction 

Let's face it: the human memory sucks. We forget in a month even the most important 
ideas in that excellent book we read. We cram the night before a test, only to forget 
everything in a week. We forget the Five Big Things we’re supposed to remember when 
assessing a project proposal. We never get around to remembering all those guitar chords 
with their many variations and configurations. The list goes on. 

What can we do? Our memory, despite its limitation, is still a powerful tool in the human 
arsenal. Sure, a new and better brain might be nice, but until that’s possible we must 
focus on making the most of what we have. Many methods for improving human 
memory retention exist, but one that stands out above the rest is active recall testing. 
Active recall testing is, basically, repeatedly exposing you to material to force yourself to 
recall it. If recall succeeds, the memory is strengthened; if recall fails, you refresh the 
memory and recall it again. 

Enter Anki, a handy little free piece of software available on all major platforms—
Windows, Mac OS X, iPhone, Android, and so on. Anki is an invaluable tool for 
creating, learning, and reviewing practically anything with some “structure” to it. From 
guitar chords to philosophical arguments to languages to productivity advice, Anki can 
help you remember it all. Anki is both flashcard software and spaced repetition software. In 
short: it presents you with a question (Who was the sixteenth president of the USA?). 
Once you’ve recalled the answer (Abraham Lincoln), this card will be presented again 
right when Anki thinks you’re about to forget, thereby refreshing and strengthening the 
memory. 

Sounds too simple, you say? Well, there is a bit more to it than that—and much more 
you can do with Anki—but that’s the basic idea.  
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The Goal 
The goal with this book is to teach you how to become an Anki master. I want to show 
you how easy it is to improve your memory and recall with a minimal amount of time and 
effort. The goal is not to help you develop a perfect memory. I don’t know how to do 
that, and you should distrust people who claim they do. What I’m providing is a tool for 
getting more from the brain you already have, not a new brain. Still interested? Let’s get 
started.  

Key Terms 
There are a bunch of key terms I want to highlight before we delve into using Anki. 
These words are used throughout the book. Don’t worry if these aren’t completely clear 
yet, we’ll be talking about them a lot in the upcoming pages. 

∗  Notes – A note is a bunch of information that belongs together. A single note 
could contain, for example: “Who was the sixteenth president?” and “Abraham 
Lincoln.” A more complex note might contain “Abraham Lincoln,” “Honest 
Abe,” “16th,”  “2-Term,” and “1861–1865.” 

∗  Note Fields – Note fields are the different parts of information contained in a 
note. This could be simple question and answer fields, or more complex fields 
such as name, nickname, order, terms, and years for the above note example. 

∗  Note Types – Notes come in various types. A note type is a group of note fields 
used to make up certain kinds of notes. For example, a “Basic” note type may 
simply contain a front and back field. A “Presidents” note type may contain the 
fields in the above example (name, nickname, etc.). An “Elements” note type may 
contain the fields symbol, atomic number, and valence electrons. 

∗  Card Templates – Notes come in different shapes and sizes. A note with various 
fields can be presented in different ways. For example, if you created a card 
template called “President Nicknames,” you could display only the president's 
name and ask for the nickname. Card templates are used to define exactly what to 
display when and where. 

∗  Cards – Each card template creates a card from a note. By making a bunch of 
card templates, multiple cards will be generated from a single note. 
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∗  Decks – Decks are groups of cards unified under a single name, much like files in 
a folder. You may have a deck called “Presidents” that contains 44 notes for every 
US president, resulting in 220 cards (assuming you had five card templates per 
president). 

∗  Collection – A collection is the sum total of all the decks in Anki. Every Anki 
user has their own collection, and multiple collections can be configured for one 
installation of Anki (such as if you have multiple people using the same 
computer). 

∗  Tags – Tags are optional labels you can give to individual notes. For example, 
you could tag the 44 president notes in the above example with the century in 
which they were president. 

∗  Studying – Studying is the general process of going through a group of decks or 
cards and either learning them if they’re new, or reviewing them if they’ve already 
been learned. 

∗  Anki – Whenever I talk about Anki, I'm referring to the free, open-source, 
spaced repetition software created by Damien Elms. As of this writing, Anki 2.0 
has just been released. Unless I specify otherwise, when I refer to “Anki” I mean 
Anki 2.0—the latest and greatest—not an older version. 

∗  AnkiWeb – AnkiWeb is the online side of Anki where you can create a free 
account and sync your Anki collection between computers and devices. 

∗  SRS – SRS stands for spaced repetition software. 

What’s Covered 
Anki Essentials attempts to cover seven general areas: 

1. Getting Started – The absolute bare-bones basics of using Anki, from installation, 
to setting up an account with AnkiWeb, to creating your first deck. 

2. Getting Familiar with Anki – The inner-workings of Anki; how decks are 
organized, how notes and cards are edited, and how your collection is managed. 

3. Creating & Editing – The world of creating Anki decks. It covers note types, 
note fields, card templates, images and sounds, importing and exporting decks, 
and adding scientific markup. 
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4. Learning & Reviewing – Specifics about studying, scheduling, and reviewing in 
Anki. Cramming, learning statistics, filtered decks, study options, and other 
topics are covered in depth. 

5. Specific Applications – Taking what you’ve learned so far and presents a variety of 
sample applications. 

6. Expanding & Enhancing – An assortment of other topics for getting the most out 
of Anki, including creating multiple user profiles, configuring Anki’s settings, 
and using advanced card templates. 

7. Additional Resources – Some final comments, as well as listing a bunch of 
available external resources and reference appendices. 

In general, I suggest you go through Anki Essentials chapter by chapter. If you are new to 
Anki, this is especially important for the first few chapters of the book. After that, 
however, if you reach a chapter that doesn't apply to your situation or tickle your fancy—
such as the chapter on LaTeX equations—don't hesitate to skim or skip it all together. 

And now, without further ado, let’s get started. 
–Alex 
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Chapter 2 

The What and Why of Anki 

Say hello to your brain. Many methods for improving human memory retention exist, but 
one that stands out above the rest is active recall testing. The easiest way to do active recall 
testing is to use spaced repetition software that manages the spacing of material for you and 
makes it easy to create, edit, and delete content. 

Your brain needs repetition to internalize material. This is where Anki helps.  

What is Anki? 
Anki can be summed up with two bullets:  

∗  Questions & Answers. Anki presents you with a question—be it a fill-in-the-blank, 
a definition, or a standard question-marked sentence—and your job is to recall 
the correct answer. 

∗  Scheduling. Based on how difficult or easy it was to recall the answer to the 
question, Anki determines the best amount of time to wait before asking you the 
same question again, thereby strengthening the memory at just the right 
moment. 

Why Use Anki? 
Anki is not the only SRS out there, or even the only good one. Some other popular ones 
include Mnemosyne, Metric, and iSRS. However, Anki is my software of choice for a 
few reasons: 
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∗  Free.1 Anki is completely free, thanks to the hard work and dedication of its 
primary creator, Damien Elmes.  

∗  Wide availability. Anki is available on most devices, including Android and iOS 
smartphones. 

∗  Easy syncing between devices. AnkiWeb hosts all of your Anki content, making it 
possible to synchronize your information across all devices. 

∗  Extensive use of shortcuts. Everything in Anki has an easy keyboard shortcut, 
making it possible to be very efficient at using it. 

∗  Extremely customizable. Anki gives a lot of control over what material to store and 
how to display it. 

Anki isn’t a cure-all; it won’t work for everything. As we’ll see in later chapters, 
information must be formatted in certain ways for it to be effectively learned and 
memorized. But the things it works well for, it works very well.  

Learn More about Spaced Repetition 
If you’re interested to read more about spaced repetition, the best place to start is the 
article Spaced Repetition by Gwern: http://www.gwern.net/Spaced repetition. This is by 
far my favorite article on the topic, a must read for anyone interested in knowing why 
spaced repetition works so well. 

 

                                                        

1 Except for the iOS app, which is currently priced at $25. 
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Chapter 3 

Installation & Configuration 

I know you’re itching to get started mastering your memory and becoming super-human, 
but before you can do any of that (because you will) you need Anki! 

Download & Install 
Head over to http://ankisrs.net and grab a free copy of Anki. On the right side of the 
web page there is a list of download links for various platforms. Anki is available for 
Windows, OSX, and many others, however this book focuses on the Windows and Mac 
version of Anki. Everything in this book should be easy to follow if you are on a different 
platform. 

Installation Instructions 
1. Download the Anki installer from http://ankisrs.net. 
2. Run it (Windows: anki-2.0.x.exe, OSX: anki-2.0.x.dmg). 
3. Follow the onscreen instructions. 
4. Run Anki (Windows: Start Menu > Anki, OSX: \Applications\Anki.app) 

Note: If you are upgrading from an older version of Anki, simply follow the 
onscreen instructions to update your existing Anki database. 

Anatomy of Your Installation 
Just for your reference, once the installation is complete the following files will now exist 
on your computer: 

∗  (My) Documents\Anki\collection.anki2 – This is the main Anki file that 
contains all the facts, cards, decks, and templates in your collection. 

∗  (My) Documents\Anki\collection.media – This folder contains all media files 
that are added to your decks, such as images and sounds. 
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Run Anki 
If you haven’t yet, go ahead 
and start up Anki for the first 
time! You should see a home 
screen like the one to the 
right. 

Create an Account at 
AnkiWeb 
Before you start creating 
content, you need an account 
at ankiweb.net.  

In the top right corner of the 
Anki window there is a Sync 

button that looks like .  

Clicking this button, or pressing Y, will tell Anki to sync with AnkiWeb. Since there is 
no account set up yet, the screenshot below should appear.  

If you already have an AnkiWeb account then log in using your existing credentials and 
hit OK. Otherwise, click on the sign up 
link or go directly to ankiweb.net and 
create an account. Then return to Anki, 
enter your account information, and hit 
OK. 

A small window will briefly appear as your 
new (empty) account is linked to 
AnkiWeb. 

Welcome to Anki! Wasn’t that easy? 



Creating Your First Deck – Anki Essentials 11 

Chapter 4 

Creating Your First Deck 

The main Anki window is the Decks page. Here you get a complete overview of 
everything contained in your collection. There's not much here, because we haven't 
created any decks or notes to learn 
from yet. But, not to worry, we'll 
be getting to that.  

There are bunch of other features 
and links on this page, but for now 
we will ignore these and get 
started making our first deck.  

Creating a New Deck 
Let’s make a deck for learning the 
capitol cities of European 
countries.  

Learning European Capitals 
From the Decks page, click the 
Add button in the top menu to add some notes. Notes—the stuff you want to learn—are 
turned into cards and organized into decks, which act a lot like folders for files on your 
computer. The Add window should appear, looking something like this: 
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Here we can see: 

∗  The current Fact Type 
(“Basic”) – Anki comes 
with two basic fact 
types: Basic and Cloze. 
We'll only be using 
Basic for now. 

∗  The current Deck 
(“Default”) – By default, 
you are adding facts to a 
Default deck.  

∗  The available 
Formatting options – 
bold, italics, font color, 
etc. 

∗  The available Fields, 
given this Fact Type (“Front” and “Back”). 

You don't want to add facts to the Default deck; you want to make a deck specifically for 
European Cities. So, create a new deck by clicking on the Default deck button. A list of all 
the available decks appears (nothing much to see here yet). Hit Add and enter the name 
European Cities, followed by OK. 

Now the Add window shows that our current deck is European Cities. It’s time to add 
some content.  

The Front field is what is displayed on the front of the card; it’s the question Anki will 
ask. The Back field is the answer that you will be required to recall. In the Front field 
textbox put “What is the capital of Greece?” and in the Back field textbox put “Athens.” 
Now hit Add. Congratulations, you just added your first fact! 

Add a few more facts to fill out the European Cities deck, such as: 
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→  Front: What is the capital of Serbia? 
Back: Belgrade 

→  Front: What is the capital of Germany? 
Back: Berlin 

→  Front: What is the capital of Belgium? 
Back: Brussels 

→  Front: What is the capital of Romania? 
Back: Bucharest 

→  Front: What is the capital of Hungary? 
Back: Budapest 

→  Front: What is the capital of Denmark? 
Back: Copenhagen 

After adding a bunch of facts, hit the Close button to return to the Decks window, where 
you will now see your newly created deck: 

 

You can see that there are (in my case) 7 New facts to learn, and 0 Due for review 
(because I haven't learned them yet). Now that you have some material, it’s time to do 
some learning. 
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Learning & Reviewing 
From the Decks window click on the name of your new deck. This takes you to the main 
Study window. Here again we see that there are 7 New facts to learn, 0 facts in the 
middle of learning, and 0 facts awaiting review.  

 

Hit the Study Now button to begin studying. 

By default, Anki presents new cards for learning in the order they were added. So, the 
first card you are presented with should be from the fact you added asking about the 
capital city of Greece. 

Think you know the answer? When you’re ready, click on Show Answer (or press 
SPACEBAR). 
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Was it easy? Hard? Did you completely forget? You now have a set of options that are 
presented after every new card: 

∗  Again – Click this if you got it wrong (or press 1) 
∗  Good – Click this if you got it right, but it took some effort (or press 2) 
∗  Easy – Click this if you got it right and it was easy (or press 3) 

There are other options in the Review window, such as Edit and More, but don’t worry 
about these yet. Once you make a selection (Again, Good, or Easy), you will be presented 
with the next card in the deck. Continue until you have completed all of the cards. 

At this point, Anki tells you that you’re done reviewing. Congratulation! You’ve started 
learning and memorizing useful information with Anki!  

NOTE: You may be required to answer the 
same card multiple times; this is because if 
you only answered Good and if this is a new 
card then Anki will ask more than once 
before delaying the card until tomorrow. 
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Click the Decks link (or hit D) to return to the Decks window. Since this material is new, 
and assuming you completed the deck, there should be zero cards due in the Getting 
Things Done deck—all the cards will be due for review tomorrow. As you get the answers 
correct more frequently and more easily, Anki will wait longer and longer before 
presenting the same card again, eventually reaching delays of weeks and months. 

The Decks window also shows how many cards were studied today and for how long—in 
my case, 14 cards in 1 minute.  

 

By default, Anki will never ask you to answer more than 100 cards per day. You don’t 
have anywhere near that many yet, but you’d be surprised how quickly they can add up.  
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Syncing with AnkiWeb 
Now that you’ve created the start of a simple deck and reviewed it, it’s time to sync your 
collection with AnkiWeb. This way the contents of your decks, as well as all your review 
and study information, will be backed-up online, accessible online, and accessible from 
any other device or computer where you have Anki installed. 

Clicking this Sync button (or pressing Y) will cause Anki to sync everything in your 
collection with AnkiWeb; it should only take a few seconds.  

And that’s it! Now your entire collection is accessible from ankiweb.net. 

* * * 
There you have it. Those are the bare bones of using Anki. Of course, there’s still so much 
more we’re going to cover, but by now you have already succeeded in creating your first 
deck and reviewing it. Give yourself a pat on the back.  

Now take a deep breath, and let’s move on! 
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Chapter 5 

Anatomy of a Collection 

How does Anki work? How is everything organized? Lets spend a moment fleshing out 
the inner workings of Anki. This may seem a bit confusing or convoluted at the start, but 
trust me, you’ll be glad in the long run if you take the time to understand this stuff. 

It All Starts With Notes 
Notes are the most fundamental pieces of an Anki collection. 

Let’s say I want to learn about chemistry—specifically, the first twenty elements on the 
periodic table and their important properties, such as the name, symbol, and atomic 
number. 

Notes, Types, and Fields 
To do this, we would create a Note Type called “periodic table” with the three Note 
Fields “name,” “symbol,” and “atomic number”: 

 

Note Types define what groups of information you can create, organize, and study. In the 
above example, the “periodic table” note type has three fields. You could also create a 
note type with generic “front” and “back” fields, or a more complex period table note type 
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with name, chemical symbol, valence electrons, common form, type, position, etc. Note 
Fields are the various components of a Note Type.  

To bring this back down to reality, let’s continue with the chemical symbols example. 
What would some of our periodic table notes contain? 

 

Once we have this information and want to learn it using Anki, we need a way to present 
the information to you, the learner. This is where Cards come in. 

Cards and Card Layouts 
As mentioned earlier, Anki works by presenting questions and answers. Card Layouts—
also called Card Templates or Card Types—determine how the note fields and their 
content will be displayed while you study and review them. Each note type has its own 
card layouts, unique to itself.  

Every single card layout has a front and a back. The front is what Anki displays to ask you 
a question, and the back is what Anki displays to reveal the answer. In “Creating Your 
First Deck,” you exclusively used the Basic note type, which contains a single card type 
called “card.” The front of this card type displays the Front field, and the back displays 
both Front field and the Back field (so you can see the original question when the answer 
is displayed). 

The following shows the front of a card (the question) and the corresponding back of the 
card (the answer). 
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Anki enables you to define what the front and back of a card look like by customizing your 
Card Layouts. Still sticking with the periodic table example, we may want to define four 
different card templates as follows: 

Template: Name to Symbol 

 

Template: Symbol to Name 

 

Template: Name to Number 
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Template: Number to Name 

 

By creating these four Card Templates, every time we create a single note, four cards for 
studying are instantly created! The fields surrounded by “{{” and “}}” will be replaced by 
the actual content of a note to create a learnable card. When we put it all together: 
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Presto! By creating a single note there are now four cards of material to learn using Anki. 
The card types within Anki are very customizable. 

Anki Defaults (What You’ve Already Used) 
In Chapter 4, when creating your first deck, you left the note types, fields, and card 
layouts all in their defaults. But what defaults, exactly, are included with Anki? 

Anki comes with two different pre-configured note types: Basic and Cloze. 

Basic 
The Basic note type is about as simple as it gets. There are two fields named front and 
back (not to be confused with the front and back of the card layout). This is the note type 
you used to create the European Cities notes in Chapter 4. 

 

The Basic note type is flexible and powerful because of its simplicity and generality. You 
could use it for pretty much anything: 

 

Cloze 
The Cloze note type was created with “cloze deletion” in mind. Cloze deletion is when a 
certain portion of text is omitted and you are required to remember what it is. For 
example: 

→  Question: The Three Stooges are ____, ____, and ____. 
Answer: The Three Stooges are Moe, Larry, and Curly. 
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This is a powerful and useful memorization method. The above question and answer 
could be made using the Basic note type, but since this is a very popular style, Anki has a 
means to make these types of notes as easy as possible. The above Q&A will look very 
different depending on which note type, Basic or Cloze, is used: 

Using the Basic Note Type 

→  ONE Basic Note’s Fields 
Front: The Three Stooges are ____, ____, and ____. 
Back: The Three Stooges are Moe, Larry, and Curly. 

→  ONE Card Created 

 

Using the Cloze Note Type 

→  ONE Cloze Note’s Fields 
Text: The Three Stooges are {{c1::Moe}}, {{c2::Larry}}, and {{c3::Curly}}. 
Extra: [any extra text you want to show on the back of the card; left blank in this 
example, because it isn’t needed] 
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→  THREE Cards Created 

 

As you can see, using the cloze fields—such as {{c1::Moe}}—causes the Cloze note type 
to automatically create a card with “[…]” on the front and “Moe” on the back. Don’t 
worry, you don’t need to remember how to type “{{c1::Moe}}”. When creating notes, 
Anki has a special “Cloze deletion” button which automatically puts the currently selected 
text between “{{cl#::” and “}}”.  

 The basic structure of the Cloze note type is shown in the following image. Basically, 
Anki automatically creates a new card for every single cloze field present in the deck. 
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Anki has a special way of using cloze deletion text, which we will cover in much greater 
detail in when talking about creating custom notes and card templates. 

Together, the Basic and Cloze notes are very powerful and will probably cover most of 
your basic note type needs. Anki enables you to create an unlimited number of different 
note types—each with their own custom note fields and card layouts—to suit whatever 
your needs may be.  

Card Layouts 
You’ve now seen a bunch of different card layout examples. With Cloze deletion, the card 
layout creates a new card for every “{{cl::…}}” field. With the Basic card type a single card 
layout displays the question on the front, and the question and answer on the back. With 
the chemistry example used at the start of the chapter, four different card layouts were 
defined to ask four different questions.  
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Enough about content. Next we’ll briefly cover how these notes and cards are organized 
together in Anki. 

How it’s All Organized 

Decks 
Decks, as you’ve probably gathered by now, are simply a collection of notes (and their 
corresponding cards). Decks are usually used to group notes in some way, such as by 
category, area of coverage, or information type. My personal Anki collection has decks for 
specific books, specific topics, and specific projects.  

Collection 
A collection, just to reiterate this once more, refers to the combination of all your decks. 
Every Anki user has a personal collection. 

Summary 
Notes are the raw information.  Once you have a note type, you can create notes by filling 
in the various note fields. In Creating Your First Deck, you added notes using the Basic 
note type to create multiple cards with front and back fields—this is not to be confused 
with the front and back of cards—which can also be called the “question” and “answer” 
side of your cards. 

But you don’t have to use just one note type. When creating notes for your decks, you can 
create as many notes using as many different note types as you like. 

The options really are endless—note types can come in many shapes and forms that are 
simple and general, or specific and complex. These can then be displayed using various 
card layouts that can create multiple cards for studying based on a single note. 
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Chapter 6 

A Day in the Life of a Deck 

This chapter is an overview of the note creation and studying processes. You have already 
created some single notes for a short deck in Creating Your First Deck. Now let’s get into 
a little more detail about the general note creation and studying process. 

The Creation Process 
Before you start creating anything, there are a bunch of questions you need to ask. 

What am I learning? 
Figure out what your content is going to look like. Will it be using images and audio 
files? Will it be basic questions and answers? Will if be a lot of “fill-in-the-blank”? 

What note types and card layouts should I use? 
You may be perfectly fine using the Basic and Cloze note types for most of your 
purposes. However, if you have something more specific in mind you’ll want to decide on 
how to organize new note types, fields, and card layouts.  

What is the best way to organize my material? 
Is this all going to go into a single deck or into multiple sub-decks? What will the decks 
be called? Will you use tags on your notes to organize them?  

Once you have these things figured out, the general creation process usually looks like 
this: 

 



A Day in the Life of a Deck – Anki Essentials 28 

We’re going to cover everything you need to know about each of these steps in upcoming 
chapters. 

The Studying Process 
Every single card created in Anki goes through the same stages: 

 

The New Stage 
New cards are those that have been created but not studied. The moment a card is 
studied for the first time, it enters the learning stage. 

The Learning Stage 
In the learning stage, cards are presented several times until Anki believes you have 
learned it—by default this is when you answer it correctly at least twice. 

The Review Stage 
From this point onward a learned card sits in the “review” stage in which Anki begins 
leaving longer and longer gaps of time between reviews. If at any point you get the wrong 
answer, a card is then considered to be in the “learning” stage again.  

As time goes on, we hope that every card in our collection transition to the review stage 
and stays there. 

We’ll get into the studying process in a lot more detail in Studying 101. 
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Chapter 7 

The 20 Rules 

What is the best, most effective way to structure the information you are going to learn 
and memorize? Your speed of learning will depend on the way you formulate the material 
present in your decks. Bad cards = bad learning! This makes a big difference. The same 
material can be learned many times faster, with much less stress and effort, if it is well 
formulated. 

Dr. Piotr Wozniak, the creator of SuperMemo, the original spaced repetition software, 
wrote a detailed list of rules and recommendations for how to create learning material. 
These will help guide you in the ways to most effectively create and organize the material 
in your Anki decks to make them as effective and efficient as possible. These twenty rules 
are organized in order of priority. 

If you want to skip this chapter and jump ahead to how to create notes with 
Anki, feel free—but make sure you come back and read this later. 

Here is my own summarized version of the twenty rules based on Wozniak’s 20 rules for 
formulating knowledge in learning. These rules are not only applicable to Anki. Use 
them to improve your learning and studying in any endeavor. 

Rules 1. First Understand 
Never memorize something if you do not first understand it! There is no value in 
memorizing a German history book, word for word, if you do not understand what any of 
those words mean. 

As an added negative, the time you will waste for “blind learning” is astronomical 
compared to learning and remembering what you understand. It pollutes and clutters your 
learning process. 
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This is a challenge when sharing decks with others. As you’ll see in the remaining rules, it 
helps to add personalization and context to your material, which makes them harder for 
others to use, and makes using other’s decks more difficult for you. 

I cannot stress this point enough: do not memorize if you do not understand! 

Rule 2. Start with the Big Picture 
Don’t memorize loosely related facts. Instead, build a picture of the whole before 
breaking it down into simple items. Read a book or chapter that puts all of these ideas 
together. Make sure you know the big picture of what you’re learning about. If you don’t 
have a clear big picture, memorizing the loosely related facts will be more difficult and 
time-consuming. 

Rule 3. Build on the Basics 
Always start with the basics, and do not neglect them. Don’t begin by memorizing 
advanced, difficult, complex ideas. Start with the simplest ideas (see Rule 4!) and build 
off of them. You can always move onto more complex things later. 

The basics take a relatively small proportion of your time to learn, but you will be glad 
you spent time on them in the end. Memorizing obvious things is not a waste of time! 
Forgetting the basics can cost you dearly in the long run both in terms of time and effort.  

Rule 4. Simplify 
Make formulated material as simple as possible. Simpler models are easier to create, 
learn, and memorize. Simplicity does not imply losing information or skipping the 
difficult parts—though if you’re not careful this could happen. Simplicity is saying the 
most with the least number of words. 

Simplicity is imperative for two reasons. First, simple is easier to remember. 
Remembering an idea is like running through a labyrinth—it’s easier when your brain 
knows exactly which way to go. The labyrinth in your mind is easier to navigate when the 
idea is simpler. Second, it is easier to schedule repetitions of simple items within Anki. 
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In general, the longer it takes to remember an idea, the simpler it needs to be. Answers, 
especially, should be as short as possible. If simplifying doesn't work, see the remaining 
rules. 

Rule 5. Use Cloze Deletion 
Cloze deletion—the act of omitting words or phrases—is easy and effective, and can 
greatly speeds up memorizing. Cloze deletion is highly recommended for beginners. 

Rule 6. Use Imagery 
A picture is worth a thousand words. Images of information are usually far less volatile 
that words. The downside of using imagery is that it can be time-consuming to create the 
material, so it isn't always worthwhile. 

Rule 7. Use Mnemonic Techniques 
Mnemonic techniques are often amazingly effective and make remembering easier. A 
mnemonic is a general term for a tool or trick that aids information retention. A common 
example is the Mnemonic Major System, a way of translating numbers into letters and in 
turn into visual words. Using this technique, a long string of numbers is much easier to 
memorize by turning it into a series of visual images. Tony Buzan is a popular writer of 
books on mnemonic techniques, such as peg lists and mind maps (two other good 
examples). 

Rule 8. Use Graphic Deletion 
Graphic deletion is exactly the same as cloze deletion except it omits portions of images 
rather than sentences. Graphic deletion is great for learning things like anatomy and 
geography. 

Rule 9. Avoid Sets 
A set is a collection of objects, such as this list of 20 rules, or “apple, pear, peach,” or the 
answer to “What countries belong to the EU?” Sets are very difficult to memorize. 
Sometimes, however, sets are unavoidable. If you must have a list of items, at least 
convert them to enumerations (Rule 10).  
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Rule 10. Avoid Enumeration 
Enumerations are lists that have been ordered. If you were memorizing this list of rules, 
ordering them by rule number is still very difficult to memorize, but it is much better than 
memorizing them in a random order. 

Listing the countries in the EU alphabetically is an example of an enumeration, as is 
listing these twenty rules in order of priority. Enumerations, even through they’re better 
than lists, are still very difficult to memorize and should be avoided whenever possible. 

If you must use enumerations then use overlapping close deletion when possible. 

Rule 11. Combat Interference 
When you learn about similar things it is often easy to confuse them. Interference is when 
knowledge of one item makes it hard to remember another item. For example, if you 
were learning English vocabulary you may constantly confuse the meanings of “historic” 
and “historical.” Another example: you could find yourself thinking, “I know the 
meanings of inept and inapt but I can't remember which is which!” This is a sure sign of 
interference. 

Interference is the single greatest cause of forgetting! So what to do about it? Detect and 
eliminate. The moment you notice yourself experiencing interference, you must make 
every effort to change your notes in some way so as to prevent the confusion. Can you 
make them personal (Rule 14)? Can you use context cues (Rule 16)? And so on. Make 
your cards as unambiguous as possible, and eliminate interference as soon as you spot it.  

Rule 12. Optimize Wording 
Sometimes words can be ambiguous or vague. Words can have different meanings, 
different interpretations, that may be clear now but won’t be in the future. Also, there are 
often single words that can sum up an entire phrase or sentence.  

Optimizing wording means conveying an idea in as few words as necessary, as clearly as 
possible. Optimized wording helps reduce errors, increase specificity, reduce response 
time, and improve concentration. 
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For example, replacing “Aldus invented desktop publishing with PageMaker but failed to 
improve. It was soon outdistanced by …” with “PageMaker lost ground to …” is an 
example of optimizing wording—it says the same thing but with much fewer words. 
(This is closely related to Rule 4: Simplify.) 

Rule 13. Refer to Other Memories 
Referring to memories helps to create context, simplify wording, and reduce interference. 
For example, replacing “shamelessly conscious of one's failings and asking in a begging 
way” with “shamelessly humble and supplicant” is an example of referring to other 
memories (assuming you already know exactly what “humble” and “supplicant” mean). 

Rule 14. Use Personalized Examples 
Enhance memories by linking them to personalized examples, which are very resistant to 
interference. For example, “What is the name of a soft bed without arms or back? (like 
the one at Robert's parents’ place)” is an example of a personalized example. 

Rule 15. Rely on Emotional States 
Strong emotions help with remembering. Vivid and shocking examples are easy to 
remember. If you illustrate with examples that are vivid or shocking you will be amazed at 
how much easier things are to remember. 

Rule 16. Use Context Cues 
Context cues are words or images that prime you for a type or answer in a simple way. 
Context cues simplify wording and put an idea within a category. For example, writing 
“author: Getting Things Done” is much shorter and simpler than “Who wrote the book 
called Getting Things Done?” 

Some other examples of context cues: “title:,” “author:,” “date:,” “math:,” “chem:,” 
“define:,” and “ex:.” 
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Rule 17. Use Redundancy 
Redundancy means presenting the same information in different ways. This is not a waste 
of time or a contradiction of the Simplify principle. Repeating information in different 
ways can encourage memorization and internalization. 

Rule 18. Provide Sources 
Except for well-tested and proven knowledge, it is highly recommended that you include 
sources. Sources help distinguish conflicting information and help judge an idea's 
reliability or importance. For example, that bit of wisdom from a friend that you want to 
internalize? Record whom you got it from, so that you can better differentiate it from 
other advice you may receive in the future. 

Rule 19. Use Date Stamping 
Date stamping means including the date a piece of information was accessed, created, or 
recorded. This is especially important for information that is volatile—i.e., knowledge 
that is subject to change over time. 

Rule 20. Prioritize 
Last but not least, don’t forget to prioritize. Some information is more important than 
other information. Some sources are better than others. It rarely makes sense to 
memorize whole books. Focus on the most important information! One way to 
implement this rule is to put less important information in parenthesis in your notes. 
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Chapter 8 

Getting to Know the Deck List 

The Deck list is your Anki “homepage.” This is where you start every time you load 
Anki, and where you go after adding material or reviewing. If you’ve been experimenting 
with Anki, your collection may be starting to fill out a bit. 

Overview of the Deck List 
The Decks list contains three main areas: the main menu, the actual deck list, and the 
bottom menu. Take a look at the following image to see all the options available to you in 
the Decks list (i.e. your collection). 

 

In the main menu, you have the following options: 

 

∗  Decks: This takes you to where you currently are. 
∗  Add: Begin creating new notes. 
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∗  Browse: Browse through all of the notes and cards in your collection (discussed 
more in the next chapter). 

∗  Show statistics: View your learning and reviewing statistics of the current 
selected deck. 

∗  Synchronize with Anki Web: Sync your collection between the computer and 
AnkiWeb. 

On the bottom menu you have the following options:  

 

∗  Get Shared: This takes you to the shared decks page on AnkiWeb, where you 
can find and share decks with other Anki. 

∗  Create Deck: Create a new, blank deck. 
∗  Import File: Anki is able to create notes by importing the data in plain text files. 

Within the main Decks list window, there are options for each deck listed:  

 

1. You can toggle to display or hide the sub-decks by clicking on the “–” or “+” on 
the left. 

2. The name of the deck. 
3. If you click on a deck’s name you will be taken to the Study page for that deck. 
4. You can see the current Due and New cards. 
5. There is an additional options menu. 

The additional options menu to the right of each deck is pretty self-explanatory: 

∗  Collapse – Show or hide all of the sub-decks within this deck. 
∗  Rename – Rename the deck. 
∗  Options – Provides a bunch of study and review options. 
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∗  Delete – Deletes the selected deck. 

Organizing Decks 
Decks can be nested beneath each other by adding a “::” to the name. The Decks page 
doesn’t show the “::” in the deck names, because it displays them using the nice tree view. 
To see how this works, select Rename from the options menu beside one of your decks. 
A dialogue box should appears that looks like this: 

 

Go ahead and change the name to something like: 

∗  Anki Essentials::Examples::Test::Test::Test::Presidents 

Now hit OK. The Decks window should refresh and show that the “Presidents” deck is 
now nested five levels deep. Now change the name back to what it was.  

Plan Out How You Will Organize Your Decks! 
The method by which you will organize your decks is completely up to you, but can save 
you a lot of frustrations and card-moving in the future. Take some time to plan ahead for 
the types and groups of decks you plan on creating. Really, you can do whatever you 
want, but here is a sample outline similar to my own to give you an idea of what it can 
look like. 

 Anki 
  Anki Essentials 
  How to Formulate Material 
 Languages 
  Deutsch  
   Basics 
   Advanced 
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  Español 
   Basics 
   Grammar 
   Nouns 
 University 
  2013-Fall 
   ECON*1234 Macro Economics 
   PHIL*3332 Philosophy of Science 
  2013-Winter 
   ECON*2010 Micro Economics 
 Personal Dev 
  Emotional Intelligence 2.0 
  Motivation 
 Productivity 
  Books 
   The Four Hour Work Week 
   Getting Things Done 
 Memory 
  Mnemonic Major System 
 Psychology 
  Books 
   Thinking, Fast and Slow 
   Nudge 
   Why Everyone (Else) is a Hypocrite 

Use a Sandbox 
One of my own personal methods for keeping my new notes organized—especially when 
creating them on the fly—is to always create new notes in a deck called “SANDBOX.” 
You could also call this an “Inbox” or “Unsorted” deck. Every now and then I clean up my 
sandbox and sort the notes therein into decks I already have, or create new decks to hold 
them. 

A Few Deck List Tips 
∗  Use special characters to sort special decks – The deck list sorts decks alphabetically. 

Therefore, if you want certain decks to be forced to the top or bottom of the deck 
list you can start the name of the deck with a special character. For example. I 



Getting to Know the Deck List – Anki Essentials 39 

put a “~” in front of my ARCHIVE deck to push it to the bottom, and an “@” in 
front of my SANDBOX deck to push it to the top. Some other special characters 
you can use, in the order they will be sorted (from top to bottom): 
!, #, $, %, &, (, *, ?, @, A–Z, [, ^, a–z, {, ~, Ä–Ž, ä–ž. 

∗  Use consistent capital or lowercase letters – Note in the previous tip that A–Z and a–
z are sorted separately. To keep your regular decks together, consistently start 
them with either capitols or lowercase letters. Also note that accented characters 
are always pushed to the end (something that will hopefully change in the 
future).  
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Chapter 9 

Everything You Need to Know 
About Creating Notes 

Before creating any notes you need to decide what deck to put them in. The easiest way 
to do this is from the Deck List page where you can click on the Create Deck button at 
the bottom of the screen. Then, open up the new deck by clicking on it in the Decks List 
page.  

(There’s nothing there yet, so you’re congratulated for being “done.”) But you don’t want 
to study, you want to create material. At the top of the screen hit the Add button to open 
the Note Editor. 

The Note Editor 
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This is the heart and soul of all note creation in Anki. This is where most of the magic 
happens! From the Note Editor you have full power to control what note type to use, 
what deck to create this note for, what note fields to use, what card layouts to use, and 
what information to contain.  

Selecting the Note 
Type 
Starting from the top-left corner we 
have the current note type (set to 
Basic in the above screen shot). 
Clicking on this pulls up a list of all 
available note types in your entire 
collection. The two defaults, Basic 
and Cloze, will be listed, along with 
any other created note types.  

This window also gives you the 
ability to manage your note types. 
Simply click the Manage button 
and you’ll be given the option to 
Add a new type and to Rename or 
Delete any existing note types. 

When adding note types, you have 
the option to add a new one based 
off of four built-in templates—
Forward, Basic & Reverse, Forward 
& Optional Reverse, and Cloze—or 
to clone (copy) any of your existing 
templates. 
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Tip! When creating new note types I recommend keeping the names as generic 
as possible so that they may be reused for other decks in other situations. 

Selecting the Deck 
Continuing along the top of the Note Editor we can see the current selected Deck. 
Depending on how you got to the Note Editor, you might need to change this to the 
deck you want to add notes to.  

Just as with note types, clicking on the current deck will display all of the decks currently 
in your collection and give you the ability to add a new deck. 

Modifying Note Fields 
From the Note Editor you also have the ability to modify, add, and remove the note 
fields for the currently selected note. In the following images you can see that I added 
two fields, Source and Timestamp, to a new note type I created called Basic+.   

The field editor 
gives you the 
ability to set the 
editing font for a 
field—how it 
displays when 
creating notes, not 
how it will display 
when studying—
as well as define 
the default sorting 
field (there can 
only be one), 
whether to 
remember the last 
input when added 
(which I 

NOTE: For the sake of explanation I have 
created a new note type called Basic+ that I 
will use throughout this chapter and the 
next. 
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configured the Source field to use, since that will usually be the same) and whether to 
treat it as a reverse text direction field (useful for some languages). You also have the ability 
to reorder how the fields will be displayed in the Note Editor. Note again that this only 
affects how the information will be displayed when creating the notes, but not when 
studying them. 

Now when we return to the Note Editor there are four fields displayed for editing: 

 

Notice that the text for Source and Timestamp are smaller than the others. When 
creating these two fields I intentionally set the Editing Font size for both to be smaller. 
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Full Text Editing Capabilities 
Anki gives you the ability to apply most of your basic text formatting. There are also a 
few other features that require some explanation. Anki implements all of this formatting 
using simple HTML. 

 

∗  Basic Formatting – Bold, italics, underline, superscript, and subscript. 
∗  Clear Formatting – This removes any and all formatting from the selected text. 
∗  Font Color – This sets the color of the selected text. 
∗  Cloze Deletion – Cloze deletion notes are easy to make using this powerful 

button, which automatically wraps “{{cl#::” and “}}” around whatever text you 
have selected. To use this feature you must using a Cloze note type or else Anki 
gives a warning.  

∗  Attach Media – Used to add images, audio files, and videos to your note.  
∗  Record Audio – Record and add an audio file right on the spot. 
∗  LaTeX, LaTeX equation, and LaTeX math environment – These three options let 

you include LaTeX code directly in your notes. 
∗  Edit HTML – If you’re feeling up to it, you can directly edit the HTML code for 

the current selected field using this option. 

A Few Notes about Cloze Deletion 
Remember cloze deletion? That’s when Anki automatically creates a card with hidden 
text for every “{{cl#::text to hide}}” in your note. There are a few things to note about 
using the Cloze deletion option in Anki. 

1. Use cloze note types. To use cloze deletion, you must be using a cloze note type, 
such as the aptly named Cloze note type that comes with Anki. If you try 
creating a cloze deletion while, say, using the Basic note type, Anki will produce 
a warning. 
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2. Don’t manually type all those curly brackets! To create a cloze deletion, select the 
text you wish to cloze delete and hit the cloze deletion button (or press CTRL-
SHIFT-C or ⌘-SHIFT-C). For example, this lets me very easily turn this: 
 The Three Stooges are Moe, Larry, and Curly. 
into this: 
 The {{c1::Three Stooges}} are {{c2::Moe}}, {{c3::Larry}}, and {{c4::Curly}}. 
Anki will now automatically create four cards; the first one looking like this: 
 Front: The [...] are Moe, Larry, and Curly. 
 Back: The Three Stooges are Moe, Larry, and Curly. 

3. Take advantage of hints. To add a cloze deletion hint, add “::yourhint” to the end 
of the cloze deletion. For example, you could turn this: 
 The Three Stooges are Moe::name, Larry::name, and Curly::name. 
into this: 
 The {{cl1::Three Stooges}} are {{c2::Moe::name}}, {{c3::Larry::name}}, and  
 {{c4::Curly::name}}. 
This will produce four cards, the second of which will look like this: 
 Front: The Three Stooges are [name], Larry, and Curly. 
 Back: The Three Stooges are Moe, Larry, and Curly. 

4. Don’t omit too much content. As a general rule, don’t create cloze deletions that 
omit a lot of text, as they will be more difficult to remember.  

5. Overlapping cloze deletions do not work. If you try to put a cloze within a cloze it 
will not work. For example, the following would not work: 
 The Three Stooges are {{cl1::Moe, {{cl2::Larry, and {{cl3::Curly}}}}}}. 

Tags 
Lastly, the Note Editor gives you the ability to add tags to every note created in Anki. 
Tags are useful for categorizing and organizing your notes across decks and within a 
deck. For example, you may want to tag notes as “about” to indicate that these notes are 
about the current deck—“What course was this deck created for?” Also, you may want to 
tag notes based on general categories such as “organic,” “analytical,” “physical,” 
“inorganic,” and “biochem” for a chemistry deck. This enables you to study cards made 
with a specific tag—maybe you only need to brush up on your organic chemistry? 
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Tip! Don’t tag your notes into “categories” already created with decks or note 
types. For example, if you have a deck for a text book, with various sub-decks for 
each chapter, don’t tag your notes “chapter-1”, “chapter-2”, etc. because this is 
redundant and unnecessary. If you want to study a specific chapter then you 
could just study that sub-deck. 

Tags are separated by spaces, so to give a single note a bunch of different tags you want to do 
something like this: chemistry physical super-important Intro_to_Organic_Chem. 

This would result in four different tags: “chemistry”, “physical”, “super-important”, and 
“Intro_to_Oganic_Chem”. 

A Bunch of Tips for Using Note Types and Fields 
There are major advantages and challenges to using multiple note fields for storing your 
information: 

∗  Use an appropriate sort field. The Basic note type sorts by the Front field, and for 
many situations this might make sense. However, sometimes it’s appropriate to 
use a specific sorting field for your notes, such as  

∗  Keep field names generic. If you make your field names too specific, like “Fall-12-
Chem-lecture#,” then you’ll be forcing yourself to create new note types with 
different fields in the future. Keep field names generic, such as “Lecture” or 
“Class Number.” 

∗  Don’t overdo it. Yes, fields are useful, but if you add twenty fields your note will 
start getting difficult and cumbersome. Sure, there may be some situations where 
it’s warranted, but in most cases stay away from note field overload. 
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Chapter 10 

Cards: Tweaking Layout and Style 
Using Card Templates 

Cards are the actual material, created from notes, which are used for studying. Card 
templates define how the information is to be presented on the front and back of study 
cards. Previous chapters have introduced the idea of card templates, but this chapter goes 
into a whole lot more details about what you can do and how with your card templates. 

Anki has many powerful features and options for card templates, giving you a whole 
range of customization and flexibility. If you're perfectly fine with plain white and black 
cards with a simple front and back, you can probably skip this chapter. That said, 
wouldn't it be nice to turn a simple card like this: 

 

Into this: 
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The Basics 
Every note type has at least one card template. Every card template has a front and 
back—a question and an answer. Note fields can be placed anywhere on the front or back 
of a card, and any text on a card can be styled in various ways. Styling and layouts are 
shared by all cards using this note type—that means all cards, not just the ones in this 
deck! So be warned: this means that if you change the Basic note type's card templates, 
they will be changed for every Basic note in your entire collection! 

Introducing the Card Editor 
From the Note Editor (and several other places) click on the Cards… button to open the 
card editor (also called the card type editor), which looks like this: 
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The card editor has five key areas: 

1. Front Template – The template definition for the front of the card.  
2. Back Template – The template definition for the back of the card. 
3. Styling – Where all the magic happens to make it look pretty. 
4. Front Preview – Using the front template and the styling, here you can see a 

preview of the front of the current note’s card—the question. 
5. Back Preview – Using the back template and the styling, here you can see a 

preview of the back of the current note’s card—the answer. 
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Editing the Templates 
Card templates in Anki use basic HTML, the same language used to create web pages, as 
well as a bunch of special things specific to Anki. 

Adding Note Fields 
Note fields are added to a card template using {{FieldName}}. To include a field 
anywhere on the front or back of a card template, simply surround the field name with 
double curly brackets. For example, the Basic note type that comes with Anki has Front 
and Back fields, and the front and back card template look like this, respectively: 

Basic note type 
Front Template 
{{Front}} 

Back Template 
{{FrontSide}} 
<hr id=answer> 
{{Back}} 

  
Here, {{Front}} refers to the content of the front note field, {{Back}} refers to the content 
of the back note field, and {{FrontSide}} is a special reserved template command that is 
automatically replaced by whatever is in the front template. The <hr…> bit is a special 
HTML element that draws a horizontal line. 

This is the simple template used in the example at the beginning of this chapter, as well 
as the cards made at the start of this guide. It’s about as easy as it gets. 

Special Note Fields 
There are a few special fields that Anki always has available for any card template, for any 
note type, in any deck: 

∗  {{FrontSide}} – Already shown in the Basic note type above. This is replaced with 
a complete copy of whatever is in the front card template. Note that this cannot 
be used inside the front template, only in the back template.  

∗  {{Tags}} – The tags from this note. 
∗  {{Type}} – The type of note that this card was created from. 
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∗  {{Deck}} – The deck that this card belongs to. 
∗  {{Card}} – The name of this card type. 

A special case: Cloze deletion 
Most cards and styling use your basic fields that contain text. Cloze fields are a very 
special kind of field, treated differently by Anki, because of their specific requirements. 

Cloze deletion, as you hopefully recall, is when certain portions of text are omitted, and 
you are asked to recall that omitted text. For example, the Cloze note type that comes 
with Anki has two fields—Text and Extra—which could look like this: 

 

This will produce three cards with each of the names blanked out in turn. The card 
template accomplishes this by using special cloze fields. In this particular case, the front 
and back templates are as follows: 
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Cloze note type 
Front Template 
{{cloze:Text}} 

Back Template 
{{cloze:Text}}<br> 
{{Extra}} 

  
The {{cloze:Text}} field automatically replaces each “{{cl#::…}}” item in the note with 
“[…]” for the front template, or the original word bolded for the back template. Here is 
what the first of the three generated cards looks like: 

 

Understanding Basic HTML 
As already mentioned, Anki’s templates and formatting are all done with HTML 
(Hypertext Markup Language), the same basic coding language used to create web sites. 

HTML gives you the ability to create lists, tables, horizontal rules, links, and more. It 
also enables basic formatting, such as bold, italics, and underline. HTML works by 
enclosing text in various HTML elements, such as the following. 

Front or Back Template Resulting Preview 
This text is <strong>bold</strong>, 
<em>italics</em> and 
<strong><em>both</em></strong>. 

This text is bold, italics, and 
both. 

This is a horizontal rule: 
<hr> 

This is a horizontal rule: 
_______________________ 
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This is a link to <a 
href=“http://www.wikipedia.org/”>Wikipedia</a>. 

This is a link to Wikipedia. 

This is one line. 
This is NOT a new line. 

This is one line. This is NOT a 
new line. 

This is one line. <br> 
This is a new line. 

This is one line. 
This is a new line. 

Note especially the link break command: <br>. Anki will only break to a new line 
if you use this command in your templates; otherwise everything stays on the 
same line. 

Editing Card Styles 
Along with basic HTML for layouts, Anki uses web styling called CSS (Cascading Style 
Sheets). Font, text styling, and layouts can all be styled using CSS. Keep in mind that all 
styling created for a card is shared by both the front and the back side of that card. 

CSS is a powerful styling system, but before I overwhelm you with details, here are a few 
of the simplest, most basic styling abilities: 

∗  font-family – Defines the fonts to use for a portion of text, such as Arial, 
Garamond, Times New Roman, or Verdana. Note: if the font name has spaces in 
it, it must be surrounded in double quotes. 

∗  font-size – Defines the font size, which can be given in pixels (px), points (pt), 
percent (%), or ems (em). 

∗  text-align – Defines the alignment of the text, which can be set to left, center, or 
right. 

∗  color – Defines the color of the text, using either a supported color name (e.g. 
red) or a six-letter HTML hex code (e.g. #ff54ts). 

∗  background-color – Defines the background color. Uses the same color options as 
“color.” 
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The Defaults 
To give you an idea of what CSS looks like in practice, take a look at the following 
styling that comes by default with the cards for the Basic and Cloze note types: 

.card { 
    font-family: arial; 
    font-size: 20px; 
    text-align: center; 
    color: black; 
    background-color: white; 
} 

The .card{…} is a special style definition that is used by the entire card. You can also 
add your own styles, such as .green{color: #00c618;}. Getting into how to use 
CSS to style is beyond the scope of this guide, but readers with some experience with 
CSS and HTML should experiment with tweaking and styling card layouts. 

Creating Multiple Cards 
Along the top of the Card Editor is a list of all the available cards for this note type. 
Remember that multiple cards templates can be created for a single note type, causing 
multiple study cards to be generated from each note. 

Click the Add button to create a new card type. By default, Anki duplicates the last card 
to create a new one. Now, for every note created, there will be two cards generated! This 
isn't so useful for the simple Basic note type, but when you get into more advanced note 
types and layouts, the power of this becomes more apparent. 

The Rest of the Card Editor’s Options 
Along the bottom of the Card Editor there are several additional options available to you: 

∗  Add Field – Lets you choose from a list of the current fields in this note type and 
add them to the front or back template.  

∗  Flip – This will “flip” the front and back templates. This only works if the back 
template has <hr id=answer> somewhere in it. 



Cards: Tweaking Layout and Style Using Card Templates – Anki Essentials 55 

∗  Rename – Rename the current card template. Keep these names generic because 
you may want to use them for something else in the future. 

∗  Reposition – Move the current card template to a different position relative to the 
other cards. 

∗  Deck Override – This allows you to change the destination deck of cards made 
with this note type.  

∗  Delete – Deletes the current card template. 

A Bunch of Card Editor Tips 
∗  Use fields for dynamic URLs – Let's say I have an Anki deck for memorizing key 

information from online news articles. I could create a note type with the fields 
“Source” and “URL,” where Source is the name of the article and URL is a full 
website URL. Then, if I use those fields in an <a href=“…”> link it will be 
customized to each individual card. For example, if I created a note with the 
following: 
 Front: The Egyptian dog Abuwtiyuw is also known as what?  
 Back: Abutiu 
 Source: Wikipedia:Abuwtiyuw 
 URL: http://en.wikipedia.org/wiki/Abuwtiyuw  
And made a card with the following for a back template: 
 {{FrontSide}}<br><br> 
 {{Back}} 
 <br><br> 
 <a href=“{{URL}}”>{{Source}}</a> 



Cards: Tweaking Layout and Style Using Card Templates – Anki Essentials 56 

I would end up with this: 

 
∗  Letting large image be large. By default, Anki shrinks larger images to fit on the 

screen. That is, an image will never display larger than the screen, even if the 
image is in fact larger. You can change this by placing the following code into the 
Style box on your card layout: 

o img { max-width: none; max-height: none; } 
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Chapter 11 

Studying 101 

Now that you have an overview of how to create and style notes, it's time to go into the 
reviewing and studying process. 

How to Study 

Studying – the general term I'm using to mean learning, reviewing, studying, etc. 
within Anki. 

In the Decks window, simply click on the deck you want to study. That deck, and all sub-
decks, will be selected. This takes you to a "summary" page showing you all the current 
New, Learning, and To Review cards. Hit Study Now and you're rolling! 

Anki presents you with the fronts of your cards. Hitting Show Answer or pressing 
spacebar immediately displays the back. 

At this point you grade your response—how difficult it was to recall this specific 
answer—which Anki uses to determine when to ask you again. 

Grading – When you judge how difficult it was for your to recall a specific 
answer. (Easy, Good, Hard, and Again). 

It's that easy! Of course, there's a lot happening behind the scenes, which is exactly what 
we’re going to talk about next. 

Card Stages and Grading Your Performance 
As mentioned in Chapter 6: A Day in the Life of a Deck, cards go through several stages in 
their lifetime: New, Learning, and Reviewing. Here’s the image again: 
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Grading in the Learning Stage 
New cards that have not been studied are immediately moved to the learning stage the 
first time they are presented. In the learning stage, the grading options are based on the 
steps set up for this deck. 

Steps – the duration and number of reviews required before a card transitions 
from the learning stage to the review stage 

By default Anki uses two steps of one minute and ten minutes. 

For example, imagine I created a brand new card. On the very first review, the card is in 
the learning stage (and step one) and after displaying the answer the grading options are:  

1. Again (<1minute), 
2. Good (<10 minutes), and 
3. Easy (4d). 

If I got the right answer (but not too easily) I'd pick “Good.” This will reschedule the 
card no more than 10 minutes in the future (the second step). If I get it right again in ten 
minutes, I've completed all the steps, so the card transitions to the reviewing stage. 

If instead I had hit the “Easy” button on a learning stage card, it would immediately 
move to the reviewing stage, regardless of what step it was on. 

Grading in the Reviewing Stage 
Once in the reviewing stage, Anki increases the interval between each review after every 
successful review. 

Intervals – the time between reviews of a single card, measured in days. 
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For example, once I've learned a card, the “good” interval may be four days; in four days, 
Anki will show it to me to review again, and if it's still good, the interval will increase to 
around ten days. 

Different gradings will result in different intervals between now and the next time this 
card is displayed. If I keep selecting "Good" every time I review a specific card, the 
intervals will constantly grow by about 2.5x, such as 4 days, 10 days, 25 days, 63 days, 156 
days, etc. 

Grading an answer "Hard" will create a shorter interval, and "Easy" will create a longer 
interval than the default “Good” increase. 

Based on which difficulty grading you give when answering a question, Anki will schedule 
the next review accordingly. 

Scheduling – When Anki sets the interval between now and the next time this 
card will be displayed. 

Alas, your memory is far from perfect, and sometimes you will forget the right answer, 
even if it’s a card you’ve already learned and answered successfully several times. In Anki 
terminology, this is called a lapse. 

Lapsing – when you forget a card that you've already learned (i.e. when a card 
moves from the Reviewing back to the Learning stage). 

A lapse causes a card to move from the reviewing stage back to the learning stage 

You will then have to study it several times to get through all the learning steps, until it 
become a review card again. 

Some cards may be too difficult or poorly made, such as by causing too much 
interference. Whatever the case, if a specific card lapses eight times, Anki marks it as a 
leech. 

Leeches – cards that you keep learning, and then forgetting (lapsing). 
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Leeches usually occur because they're poorly made, they're breaking some of the 20 rules, 
or they're too difficult. Anki suspends leeches so they are no longer scheduled for review. 

Scheduling Siblings 
One other things to note is that Anki tries to prevent sibling cards from appearing next to 
each other during reviews. 

Siblings – the “sister” cards created from a single note. 

Limiting New and Review Cards 
Anki limits both the number of new cards and the number of review cards that can be 
viewed each day. These limits are defined in the study options for each deck. The defaults 
are: 

∗  New cards per day: 20 
∗  Maximum reviews per day: 100 

The reasoning behind these limits is pretty straightforward: don't try to learn a thousand 
things at once! When you hit either of these limits, Anki will warn you when attempting 
to learn more: 

“Today's review limit has been reached, but there are still cards waiting to be 
reviewed. For optimum memory, consider increasing the daily limit in the 
options.” 

And: 

“There are more new cards available, but the daily limit has been reached. You 
can increase the limit in the options, but please bear in mind that the more new 
cards you introduce, the higher your short-term review workload will become.” 

All of these limits, as defined for each deck, are overridden by their parent's limits. Say 
you have a deck called Books and a bunch of sub-decks for various books. Also imagine 
that each of these sub-decks has a limit of 100 reviews, but so does the parent Books 



Studying 101 – Anki Essentials 61 

deck. So, if you do 90 reviews on the first book, Anki would only let you do 10 reviews 
on the second book, and then warn you that the daily review limit has been reached. 

Heed Anki's warnings! But, if you must study more there are two ways to do so. The first 
is to increase the daily limit for a deck, and the other is to create a Custom Study deck. 
Both of which are explained in the next chapter. 

Study Note Options 
While studying a specific card there are a bunch of useful study card options that you 
should get familiar with. These can be found on the bottom right corner of the study 
screen under the button labeled More: 

∗  Mark Note (*) – marking a note is a non-specific way to “star” a note: if you 
notice a problem, or think you might want to make a change to this card (new 
example? better story? change colors?), add a Mark so you can find it again later. 
You can use marks to mean anything, but generally it means something like 
“inspect me later.” 

∗  Bury Note (-) – burying a note will prevent it from appearing again in this session. 
As soon as you restart Anki, it will appear again as normal. This can be used as a, 
“This isn’t important to learn right now” action. 

∗  Suspend Card (@) – suspending a card, unlike burying, will remove a card from 
the learning process completely until it is manually unsuspended. This is useful if 
you want to force a delay on a card, such as “I won’t be ready to learn this for a 
while.” Suspending a card can also be a way to give it “hard mark,” as in “inspect 
me later, and don't show me again!” 

∗  Suspend Note (!) – if a note comes in multiple cards, you may want to suspend the 
entire note instead of just a particular card, for the same reasons you would 
suspend just a card. 

∗  Delete Note (DEL) – delete the current note.  
∗  Options (O) – view the study options for the current deck (explained in the next 

chapter). 
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∗  Replay Audio (R), Record Own Voice (SHIFT-V), and Replay Own Voice (V) – these 
three options, especially the last two, are particularly useful when using Anki to 
learn languages. 

Use these options and take the time to remember their keyboard shortcuts to improve the 
flow of your Anki studying. 

Some Basic Studying Tips 
∗  Kill Leeches: Edit, Delay, or Delete. Periodically, in the card browser, review all of 

the leeches in your collection and process them one by one. Think about why this 
is a leech. Was it labeled as such by mistake? Does it break one of the 20 rules? 
Then decide to either:  

1. Edit: fix it and restore it; 
2. Delay: save it for later by suspending it and removing the leech tag; or 
3. Delete: get rid of it! 

∗  Be liberal with marks. Don't be shy, use those marks whenever a card strikes you 
as having a problem, needing an update, or anything else. 

∗  Use keyboard shortcuts. Keyboard shortcuts make the entire studying process super 
fast and easy. In the learning stage, grade your answer as Again, Good, and Easy 
using 1, 2, and 3, respectively. In the Reviewing stage, grade your recall as Again, 
Hard, Good, and Easy using 1, 2, 3, and 4, respectively. In all cases, use 
SPACEBAR to both show the current answer and grade your recall as Good. Mark 
(*), bury (-), and suspend (!) notes as appropriate. 

∗  Fix mistakes right away. When possible, if you notice a mistake in the current 
card, just fix it right away. It's dead simple. Hit the Edit button or press E, 
quickly make the change, and hit ESC to return to the study window. 

Tweaking Anki's Preferences 
There are several settings in Anki’s preferences that affect the way Anki handles studying. 
All of the following require opening Anki’s preferences window and are completely up to 
your personal preference. 
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∗  Timeboxing study sessions. An hour of straight Anki can be exhausting. One 
solution to this problem is to timebox your study sessions: set the Timebox time 
limit value to the amount of time you want to study before taking a short break. 
For example, setting it to ten minutes will cause Anki to display a small message 
telling you how many cards you've studied in the past ten minutes. 

∗  Force Anki to wait the full step length. If the learning steps in a deck are one and 
ten minutes, Anki will wait ten minutes after the first successful review to show it 
again. However, if there are no cards left to study, Anki will just show it right 
away. By default, if a card is scheduled in the next 20 minutes, Anki will just 
display it right away if there's nothing else. In Anki Preferences window you can 
change this by setting the Learn Ahead Limit box to any value you want. If you 
set a value of zero Anki will always wait the full delay until asking you to review a 
card again. 

∗  Studying late into the evening? Since Anki schedules in days, you may run into 
problems when your “days” don't actually correspond to real days, because you 
stay up too late. By default, Anki treats a new day as starting at 4am. You can 
change this by setting the Next day starts at box to whatever new value you want. 

∗  New cards first, last, or mixed? You can change when new cards are displayed 
during a study session. There are three options in a drop-down box: mix new 
cards and reviews (the default), show new cards before reviews, and show new 
cards after reviews. 

∗  Don’t display the number of scheduled cards. If you don’t want to see the number of 
new, learning, and reviewing cards while studying, you can disable it by 
deselecting the “Show remaining card count during review” checkbox. 

∗  Don’t display the review intervals. If you don't want to see the review intervals 
above the answer/rating buttons while studying, disable them by deselecting the 
“Show next review time above answer buttons” checkbox.  
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Chapter 12 

Advanced Studying and Retention 

This chapter goes into a little more detail about the various study options available in 
Anki. You may want to skip past it if you're just getting started, but be sure to come back 
and take a look later on if you do. 

Custom Study: Studying Outside the Normal Schedule 
Usually, Anki does all the scheduling for you and there aren’t any problems.  

In the previous chapter I mentioned that Anki limits the total number of new and review 
cards per day. What should you do when you’ve completed all the cards Anki has 
scheduled for you, but you want to study more? Maybe you have some time to kill, or 
maybe you want to review again because your test is tomorrow morning?  

Any studying, outside of the regularly schedule, is done by creating a Custom Study deck. 
To do this, open the deck you want to study and hit the Custom Study button at the 
bottom. There are various types 
of custom studies, which are 
fairly self-explanatory: 

Doing a custom study session 
will create a temporary Custom 
Study deck, containing all of the 
filtered cards, and automatically 
open it to begin studying. 
Deleting this new deck will 
return everything to its rightful 
place. 
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Note that the first two options don't actually create a custom study deck; they just 
temporarily modify the study options of the current deck. 

Filtered Decks 
Filters are a powerful way to create decks based on some specific search criteria, “stealing” 
material from your other decks. 

For example, you can create a filtered deck that pulls the 20 most-difficult cards in your 
entire collection and puts them in a temporary deck called “20 Worst Cards.” Then, 
whenever you want to review your twenty worst cards, simply open that filtered deck and 
study them. 

Once a filtered deck has been reviewed or deleted, all its cards return to their normal 
places—what's called their home deck—leaving the filtered deck empty. These can then 
be “repopulated” whenever you want to use them again. 

Creating Filtered Decks 
Go to Anki main window and then from the main program menu go to Tools > Create 
Filtered Deck (or hit F), which brings up the Create Filtered Deck window: 
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Here you can enter in any search criteria you’d like, such as limiting yourself to a certain 
deck(s), tags, or note types. This search uses the standard Deck Browser searching 
options, discussed in more detail in Getting Familiar with the Card Browser.2 

You can also define a limit to the number of cards to “pull” from your other decks, and 
the selection criteria to use to determine which cards to take from the search results: 

∗  Oldest seen first 
∗  Random 
∗  Increasing Intervals 
∗  Decreasing Intervals 
∗  Most Lapses 
∗  Order Added 
∗  Order Due 
∗  Latest Added First 

The two remaining options require a bit of explanation: 

∗  Reschedule cards based on my answers in this deck. If this is not checked, then your 
reviewing will not influence the regular scheduling of the cards that will be pulled 
into this filtered deck. If it is checked, these cards will be treated as they normally 
would. Depending on what you’re creating a filtered deck for, you’ll have to 
decide whether you want this or not. 

∗  Custom steps (in minutes). You can optionally set custom steps to be used during 
the learning stage of a card (explained in the next section).  

Filtered Deck Options 
When viewing a filtered  deck, you may notice that the bottom menu options are 
different than for a regular deck: 

                                                        

2 See also http://ankisrs.net/docs/manual.html#searching for a complete list of all search options. 
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∗  Options – Review or update the filter options set up when creating this filtered 
deck. 

∗  Rebuild – re-run the filter to pull all matching cards into this deck. 
∗  Empty – return all cards to their original parent decks. 

A Filtered Deck Example 
How would you create a filtered deck like the “20 Worst cards” example given above? It's 
simple: 

1. From the main Anki window, go to Tools > Create Filtered Deck….  
2. In the Search field put "*"—that is, search throughout the entire collection. 
3. Limit the search to 20 results, with cards selected by "Most lapses." 
4. Disable both checkboxes. 
5. Hit Build. 

There are many possible uses with filtered decks. You could create filtered decks for every 
card tagged “science”; for 50 random cards from your entire collection or a specific deck; 
or for the 25 most recently added cards in a specific sub-deck. 

Delving into the Study Options 
Every deck has a collection of study options that define things like how many new cards 
to show per day, what the maximum interval between reviews can be, and when to mark a 
difficult card as a leech and suspend it. 

Open the study options for a deck by selecting Options from the menu next to each deck 
in the Decks list page:  

Study Options Groups 
Each deck is assigned an options group. A single such group comes standard with Anki 
and is aptly named “Default.” 
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Study options groups are useful because they let you create saved study options that can 
be used across multiple decks. Different decks can be assigned to different study groups, 
as needed. 

From the options menu next to the Options group dropdown, you can Add a new study 
options group, Delete the current group, and Rename the current group. If you make a 
new study group for a parent deck and want all its sub-decks to use that options group as 
well, you can use the Set for all sub decks option in this list. 

The following images show the 
settings for the Default study 
options group. Most of the 
options are pretty self-
explanatory, so give them a 
look-over to see what kind of 
control you have over how Anki 
behaves while studying. 

New Cards 
The new cards tab lets you 
control how new, unlearned 
cards are to be treated. The 
starting ease setting, set to 250% 
by default, is the multiplier that 
will be used on new cards 
graded as “Good” once learned 
(which is why the old interval is multiplied by 2.5 to get the new interval). 
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Reviews 
The reviews tab gives you 
control over how to treat cards 
in the reviewing stage. The 
Easy Bonus is an additional 
multiplier on top of the 
standard 2.5x multiplier to give 
cards graded as “Easy” an extra 
boost in interval size.  

 

 

 

 

Lapses 
The lapses tab lets you control 
what happens when you lapse 
during a review (when you fail 
to recall a card that is in the 
reviewing stage). The main 
setting to discuss is New 
interval. This allows you to 
define what the new reviewing 
interval will be, relative to the 
current interval before 
forgetting this card. For 
example, if you set this to 10% 
and the previous interval was 50 
days, the new interval—after 
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successfully transitioning 
through the necessary steps to 
turn the now-learning card into 
a reviewing card again—would 
be 5 days. 

General 
The General tab contains a few 
general options that are all 
pretty self-explanatory. 

Description 
This final panel lets you enter a 
description to show for the 
current deck. 

A Few Example Study Option Groups 

Default 
The default study options group is useful for most purposes, with maybe some minor 
tweaks.  In general, you may find that this is all you need. 

Archive 
I use a study options group called Archive with the following settings (the rest are the 
same as the Default group): 

∗  New cards/day: 0 
∗  Maximum review/day: 0 

I use this for decks I don't want to remove, at least not yet, but for whatever reason I don't 
want them to clutter my learning process, and I don't want to suspend all of the cards.  
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Weekly 
I also have a study group called Weekly with the following: 

∗  Maximum reviews/day: 5 
∗  Maximum interval: 7 days 

I use this for a very specific deck I have with reminders, cool images, and inspiring quotes 
that I want to view at least once a week, limited to only 5 a day, so it doesn’t clutter my 
learning. 

Anki Studying Statistics 
Anki provides a variety of statistics about the state of your studying and learning. From 
the Decks window, select any deck and then click on the "Show statistics" button (or 
press SHIFT-S).  

This displays all of the available stats for the current deck. (To see the stats for you entire 
collection select the “collection” radio button on the bottom of the screen.) You can also 
view stats for the past month, past year, or entire life of the current deck. When you first 
start using Anki there won't be too much useful information here, so don't be 
discouraged if your charts aren’t too informative at the beginning. There are eight specific 
areas on the statistics page. 

∗  Today – A short summary report of your activities today.  
∗  Forecast – A projection of the number of reviews that will be due in the future. 
∗  Review Count – The number of questions that you’ve answered. 
∗  Review Time – The time taken to answer questions. 
∗  Intervals – The length, in days, of the delays until reviews are shown again. 
∗  Hourly Breakdown – The review success rate broken down by each hour of the 

day. 
∗  Answer Buttons – The number of times you’ve pressed each button. 
∗  Cards Types – The division of cards in your decks. 
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Chapter 13 

Getting Familiar with the Card 
Browser 

We’ve now reviewed how to view and organize the decks of cards in your Anki collection, 
as well as how to create notes and cards. How do we dive into those decks to view, edit, 
and move around the actual notes they contain? 

From the Decks list click on Browse (or hit B) to open the card browser. 

Overview of the Card Browser 
The card browser has four main sections: 

 



Getting Familiar with the Card Browser – Anki Essentials 73 

1. The main menu has options for modifying/moving the currently selected notes. 
2. The search area allows you to search for notes. 
3. The deck filter lets you easily find all the cards within a certain deck or group of 

decks. 
4. The basic editing areas let you do exactly that: basic editing of the selected note. 

The Main Menu Options 
From the main menu along the top of the Browser, you have the following options: 

∗  Add – Open’s the Add window to start adding notes, by default using the 
currently selected deck. 

∗  Info – The 
Info option 
displays a 
bunch of 
detailed 
statistics 
and 
information 
about the 
selected 
note, such 
as when it 
was created, 
when it’s 
due next, 
how many 
times you’ve 
reviewed it, and how “easy” Anki has rated it, based on your studying statistics. 

∗  Mark – Marking cards—you could also call it “staring” them—can be used to 
note that there is something special about these cards. You could use this to 
mean “cards with typos” or “cards I need to split up” or something else. 
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∗  Suspend – Suspending a card will prevent Anki from scheduling it for any future 
learning or review. Use this if you have any reason to no longer want to review 
the card, such as if it is unnecessary information (but you don’t want to delete it) 
or it needs to be fixed before reviewing. 

∗  Change Deck – This is how you move cards from one deck to another. 
∗  Add Tags – This allows you to add tags to notes in bulk. You could open each 

individual task and edit the tags there, but if you select a group of notes and use 
the Add Tags button you can add tags to all of them in one go. 

∗  Remove Tags – Same the above, except it lets you bulk remove tags. 
∗  Delete – Exactly what it sounds like: delete the currently selected cards. 

Selecting Cards by Feature, Deck, Note Type, and Tag 
The left side of the browser contains a bunch of ways to automatically search for specific 
parts or types or sections of your collection. 

Cards by Feature 
The first eleven options in the left menu let 
you view the following decks: 

∗  Whole Collection – Show everything 
in your collection. 

∗  Current Deck – Show everything in 
the current selected deck. 

∗  Added Today – Show all cards 
created today. 

∗  Studied Today – Show all cards 
studied today. 

∗  Again Today – Show all cards to be 
re-reviewed today. 

∗  New – Show all new (unlearned) cards. 
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∗  Learning – Show all cards in the learning stage. 
∗  Review – Show all cards in the review stage. 
∗  Marked – Show all marked cards. 
∗  Suspended – Show all suspended cards. 
∗  Leech – Show all cards Anki deems are leeches. 

Cards by Deck 
After the special feature options, the left menu displays 
all of the decks—sorted alphabetically and into their sub-
decks—contained in your collection. Click on these if you 
want to view all the cards within a deck or branch of 
decks. 

Cards by Note Type 
You can also view all the cards from a specific note type, 
such as Basic or Cloze. 

Cards by Tag 
Just as with Note Types, you can view all cards that 
contain a specific tag. Anki has some automatically 
created tags, such as Leech and Marked.  

For every one of these side menu options—feature, deck, note type, or tag—clicking on 
the item displays all of the cards that fall within that category. 

Searching Within the Browser 
The simplest way to view all of the cards from a specific deck is to click on that deck in 
the left decks area. What this is doing is automatically running a search for ‘deck:Anki 
Essentials,’ for example. There are many specific search options that can be used if you 
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need to do some manual nitty-gritty searching and can be found in the official 
documentation at http://ankisrs.net/docs/dev/manual.html#searching. 

Editing Cards on the Fly 
The card Browser allows you to quickly edit cards within your decks. When selecting a 
card from the search results list, the bottom-left edit area allows you to make any instant 
modifications or changes to the current note. 

Moving Cards Between Decks 
To move a card from one deck to another, select the cards to be moved in the card 
browser and hit Change Deck from the main menu. Select the new deck, hit Move 
Cards, and you’re done! 

Changing Note Types 
You may notice that when previewing a note’s fields there is no option to change the note 
type, like when creating notes. Different note types have different fields, so it isn’t as 
simple as selecting the note type 
from a list to change it. 

To change note types, select the 
notes to be changed (they must all 
be of the same note type) and from 
the main Anki menu go to Edit > 
Change Note Type (or press 
SHIFT-CTRL-M) to open the 
following window: 

Here you can select which note 
type to change this card to, and 
choose which cards and fields to 
map between the two.  
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Chapter 14 

Enhancing Notes with Images, 
Sounds and Other Media 

Anki lets you easily add various types of media to your decks, including images, sounds, 
and videos, all of which are automatically synced with AnkiWeb and across your various 
Anki devices.3 All of these can greatly enhance your experience with Anki, if you use 
them right.  

Regardless of the type of media, the easiest way to add some is to simply drag and drop it 
into the note editor: 

 
                                                        

3 Older versions of Anki required a complex and often times error-prone setup of a special 
Dropbox folder for syncing media, but no longer! 
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This automatically inserts the full images and saves it to the Anki collection folder: 

 

That’s it! You’re creating notes and cards with images. 

Alternatively, you can click on the “Attach pictures/audio/video” button  or press F3 to 
open the file browser to browse to and select your desired image. 

Easy Ways to Capture Images on your Monitor 
Your specific poison will vary, but if you are capturing images from your desktop to be 
added to Anki, these are the tools I recommend: 



Enhancing Notes with Images, Sounds and Other Media – Anki Essentials 79 

∗  For Windows, download the free Greenshot (http://getgreenshot.org/) software 
and get familiar with it. It will likely do all the screen capturing and editing you 
need. 

∗  For OSX I use the built-in screen capture tool. Simply press ⌘4 to enter 
screen capture mode (optionally, hit spacebar to capture the view from a specific 
program. This saves an image to your desktop. To simply “copy” what you 
capture and paste it into Anki, use ⌘⌥4 instead. If necessary, I use Preview to 
make any minor modifications to the image before adding it to Anki. 

Notes on Audio Behavior 
When studying a card with audio, you may want to replay the sound. You can easily do 
this by hitting the R key during studying. 

Some Things to Keep In Mind about Media 
∗  Beware large images. Technically, there is no limit to the size of images added to 

Anki. However, every image you add must be synced with AnkiWeb and across 
your various devices, and larger images mean longer waits. Do yourself a favor: 
make your media as large as needed, but no larger. 
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Chapter 15 

Math, Equations, and Scientific 
Markup Using LaTeX 

LaTeX, for those of you who have never heard of it before, is a high-quality typesetting 
system. (“Say what!?”) That is, LaTeX separates the style of a document from the content. 
LaTeX is commonly used in the scientific world for writing and producing journal 
articles, among other things, and is especially well known for its ability to produce 
equations.  

Anki takes advantage of the powerful math, equation, and scientific markup abilities of 
LaTeX, so that you can use them in your cards. If this is all a little too abstract, let’s clear 
things up with an example. 

How LaTeX Works 
LaTeX let’s you create elegant equations and notations using the special markup. For 
example, the following markup: 

\delta (x-\alpha ) = \frac{1}{2\pi } \int_{-\infty }^{\infty } e^{ipx}e^{-ip\alpha }dp 

will tell LaTeX to display an equation like this: 

 

Much prettier, no? 
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Adding General LaTeX, Math, and Equations in Anki 
As mentioned, you can use these powerful LaTeX features in Anki by using any of Anki’s 
special LaTeX commands. 

General LaTeX  
If you want to add some generic non-equation LaTeX to a note, simply wrap your 
LaTeX code between “[latex]” and “[/latex]”. This is useful if you already have LaTeX 
code you want to use to create a card, or if you want to use a specific LaTeX feature in a 
card. For example, you could add a LaTeX table using the following code:4 

[latex] 
\begin{tabular}{ l c r } 
1 & 2 & 3 \\ 
4 & 5 & 6 \\ 
7 & 8 & 9 \\ 
\end{tabular}} 
[/latex] 

This would give an output like: 

 

In other words, you can add any LaTeX content to Anki using the [latex] environment. 
You could even use it to add equations, but Anki simplifies this by creating commands 
specifically for that. 

LaTeX Equation and Math Environments 
In standard LaTeX, you would add inline math by wrapping it in dollar signs. You could 
as a simple equation like 2 + 2 by writing “$2+2$”. You would write stand-along 
equations (on their own line and centered on the page) using either a “$$” environment 

                                                        

4 This example is adapted from http://en.wikibooks.org/wiki/LaTeX/Tables.  
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or something like a “\begin{equation}” environment. In Anki you can do the same by 
wrapping your LaTeX equation in either “[$]” and “[/$]” or “[$$]” and “[/$$]”. 

Take a look at this example to get an idea of how the equation mode and math mode 
differ. The following note text will produce the card that follows it: 

This is in equation mode: 
[$]\frac{a}{b+1}-\pi[/$] 
This is in math environment mode: 
[$$]\frac{a}{b+1}-\pi[/$$] 

 

To simplify it, equation mode will produce smaller and more compact images than the 
math environment mode. 

Note that you could type [latex]\begin{equation*}… instead of [$$]…, but the Anki 
notation makes things simpler. Note also, in that case, that if you wanted to create an 
aligned math environment you could do so, for example: 

[latex] 
\begin{align*} 
x & = a + b \\ 
~ & = 4 + 5 \\ 
~ & = 9 
\end{align*} 
[/latex] 

This would produce: 
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Where does it go? 
When Anki generates your cards, any LaTeX content between any [latex], [$], and [$$] 
fields are automatically turned into an image and saved along with all your other images 
so that it’s available across all your devices. 

LaTeX Must Be Installed Separately 
Unfortunately, LaTeX cannot be installed automatically with Anki, so you’ll have to 
install it yourself. Luckily, LaTeX is available on all major computer platforms for free! 
Getting LaTeX installed and configured is beyond the scope of this guide, but here are 
some links to get you started: 

∗  On Windows install MiKTeX (http://miktex.org/). 
∗  On OSX install MacTex (http://www.tug.org/mactex/).  
∗  On Linux, use your distro’s package manager to obtain LaTeX.5  

In all cases, dvipng must also be installed. Since I am personally using a Mac computer, I 
simply installed MacTex with all of the default packages, and everything works. If you 
run into any problems, you’ll have to go searching the internet or post your issues on the 
official Anki forums (see the Additional Resources chapter).   

The Easiest Way to Generate Equations 
For simple equations, you may be confident enough in your LaTeX skills to write them 
on the fly. For most of us, however, the chances of making a mistake are high, only to 
discover this when attempting to review your cards and get ugly “Latex Error!!” messages. 
                                                        

5 To be honest, I don’t fully understand what this means. If you don’t either, and you’re using 
Linux, you might want to switch platforms. 
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The easiest way to create complex (or simple) equations for Anki is to use a LaTeX 
equation generator such as this one from codecogs.com.6 Once the equation looks right, 
copy and past the code into your note, and don’t forget to wrap it in [$] [/$] or [$$] 
[/$$]. 

For example, I used the codecogs.com equation generator to create the large Dirac delta 
function used at the very start of this chapter in less than twenty seconds. It would be a 
real pain to write this off the top of my head, without knowing if I made a mistake! 

Note that you could also drag the LaTeX image produced on the website into your Anki 
deck, rather than copying and pasting the raw LaTeX code, though this would make it 
more difficult to add any changes or make any updates in the future. 

The internet is full of web sites and documents with complete lists of common LaTeX 
symbols and math markup, so when in doubt, Google it out.7 

Using Cloze Deletion in Equations 
There are generally two approaches to using cloze deletion with equations.  

The first involves manually creating different equations with cloze deletion text in them. 
For example, the Dirac delta function from the beginning of this chapter could be 
modified to better suit a card by splitting up the equation: 

→  Front: [$$]\delta (x-\alpha ) = \frac{1}{2\pi } \int_{-\infty }^{\infty } […][/$$] 
Back: [$$]e^{ipx}e^{-ip\alpha }dp[/$$] 

This would produce a card with the following back of a card (using the Basic card type): 

                                                        

6 http://www.codecogs.com/latex/eqneditor.php  
7 See, for example, http://web.ift.uib.no/Teori/KURS/WRK/TeX/symALL.html and 
http://amath.colorado.edu/documentation/LaTeX/Symbols.pdf. See also 
http://www.stdout.org/~winston/latex/latexsheet.pdf for an excellent list of the many commands 
and options available in LaTeX. 



Math, Equations, and Scientific Markup Using LaTeX – Anki Essentials 85 

 

An alternative approach would be to use the standard cloze deletion notation. For 
example: 

→  Front: [$$]\delta (x-\alpha ) = \frac{1}{2\pi } \int_{-\infty }^{\infty } {{c1::e^{ipx}e^{-
ip\alpha }dp}}[/$$]  
Extra: The Dirac delta function. 

This would produce a front and back of a card (using the Cloze card type) as follows: 

 

This second technique has the advantage of allowing you to add multiple cloze deletions 
to a single note, however the tradeoff is that your notes get more complex and harder to 
change with all the LaTeX math code and cloze deletion code, so beware! 
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Expanding the Built-in LaTeX Capabilities 
LaTeX settings are configured by note type. That is, every note type receives the default 
LaTeX environment settings but can be configured manually if desired.  

From the note editor, click on the note type button to bring up the note type browser, 
and hit Manage. From there, select the desired note type to configure and hit Options. 
This will display the LaTeX options for this note type, such as that for the Basic note 
type, pictured below: 

 

If you don’t understand what’s happening here, don’t worry about it—you will likely 
never need to make any changes here. But in case you do need to add a custom package or 
adjust the defaults, now you know where it is. 
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Some Things to Keep in Mind 
Here are a few important things to keep in mind when creating LaTeX equations with 
Anki: 

1. Beware of issues with curly brackets. Remember how cloze deletion uses double 
curly brackets, such as {{cl1::….}}? Well, LaTeX math also often uses curly 
brackets, such as \frac{a}{b}. So, keep an eye out for double curly brackets in your 
LaTeX equations, and simply add spaces between them when they crop up to 
prevent your LaTeX notes from breaking your card templates. 

2. Formatting within math environments ([$$] … [/$$]) is ignored. Don’t bother 
getting all LaTeX-formatting-fancy with your math equations, because it will 
simply be ignored by Anki. 

3. Import custom packages if you have special needs. If you’re using LaTeX in Anki for 
some advanced chemistry work or music theory, for example, you may need to 
add a package to your note type’s settings, such as \usepackage{chemarrow}, 
to get the commands you need to work.8 

4. Generate LaTeX images in bulk for Anki Mobile. The first time a card is viewed 
Anki generates an image from the LaTeX. Then, when viewed on a mobile 
device, the image is displayed—the mobile app cannot generate LaTeX images 
by itself. This means you must view every card with LaTeX content at least once 
before syncing it to a mobile device. Since this might not be ideal, there is a 
workaround: in Anki (on a computer) have Anki generate all LaTeX images in 
bulk by going to Tools > Maintenance > Unused Media. Now sync everything 
and your decks will have LaTeX images for your mobile devices! 

 

                                                        

8 If you simply cannot avoid double curly brackets in your equations, you’ll have to add “{{=<% 
%>=}}” to your card template, and switch the {{FieldName}} in your template to 
“<%FieldName%>”. 
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Chapter 16 

Sharing Decks 

In general, it is much better to create your own decks, but sometimes it just isn't practical 
or ideal. This chapter covers the ins and outs of sharing your decks with others and 
adding shared decks to your collection. 

Using Anki's Deck Sharing System 
Some people choose to make their decks available to anyone who may be interested in 
them. To view all publicly shared decks, either click on the Get Shared button in the 
Deck List window bottom menu or go directly to https://ankiweb.net/shared/decks/. 

Here you can peruse an assortment of shared decks from a variety of categories. When 
you find something that piques your interest, hit the big green Download button to 
download the *.apkg file, which you can then import into Anki. 

Importing Decks 
From the main Anki menu go to File > Import…, or click on Import File from the Deck 
List window, or press CTRL-I, or simply double-click on an Anki *.apkg file. 

Anki supports importing various types of files: 

∗  Plain text files with fields separated by tabs or semicolons (see the next chapter 
for details on this),  

∗  Anki 2.0 decks (*.apkg), 
∗  Anki 1.2 decks (*.anki). 
∗  Mnemosyne 2.0 decks (*.db), and 
∗  Supermemo XML exports (*.xml).  
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Just select the file you want to import and Anki will display details on the import 
(whether it succeeds or fails, whether it detected any problems, etc.). 

Exporting Decks 
From the main Anki menu, go to File > Export… or press CTRL-E. This brings up the 
Export window: 

 

There are three export formats available: 

∗  Anki Deck Package (*.apkg) – the standard Anki 2.0 deck format, which 
conveniently includes all images and media within a single file.  

∗  Notes in Plain Text (*.txt) 
∗  Cards in Plain Text (*.txt) 

When exporting an Anki deck package you have the option to not export images and 
other media with it. You can also choose to export the scheduling information.   
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Sharing Your Decks on AnkiWeb 
To make one of your own decks available to the public on AnkiWeb, go to 
http://ankiweb.net and log in. On the Decks page you'll se the familiar options drop 
down next to each deck. However, there is now a fourth option that lets you share a deck: 

 

When you click on Share you're brought to a page where you must enter in a title, 
optional tags, and description for the deck. After agreeing to AnkiWeb's terms and 
conditions, hit Share. Now your deck is available to anyone who wants to download it! 

Some Sharing Tips 
∗  Starting over. Want to start over with a deck from scratch? Export it without 

scheduling information, delete the deck from Anki, and then import it again. 
Now it will be completely clean of any scheduling information and you can start 
from scratch. 

∗  Make changes. Try to customize or personalize shared decks in some way to make 
them more memorable. Tweak some examples, change some card layouts, do 
something to make it more personal and relevant.  
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Chapter 17 

Creating Notes in Bulk 

Sometimes it's inconvenient or impractical to create hundreds of notes one-at-a-time. 
Sometimes you have raw data from your own work or from someone else that you might 
wish you could magically import into Anki and have it generate all your notes for you. 
Well you can! 

Anki allows for the bulk import of data using plain text (.txt) files. 

Creating the Text File 
Bulk imports work by defining, in a plain text file, the fields to be used, how they will be 
separated, and then listing the content for the notes to be created. 

Anki uses the very first link of the document to figure out how the fields are separated. 

Fields can be separated by commas, semicolons or tabs, as long as the use is consistent 
throughout the text file, and as long as there isn’t any confusion about which one you’re 
using. 

Every other line in the text document is compared to the first line. If it matches the 
layout, a note is created with that content. 

For example, the following text file will create four notes with three fields each (assuming 
I’ve already created a note type with three fields for me to map these to): 

Hydrogen; H; 1 
Helium; He; 2 
Lithium; Li; 3 
Beryllium; Be; 4 
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A popular method for creating a text file for importing into Anki is to export a 
spreadsheet to a CSV (comma-separated values) text file—but be mindful; if any of your 
content contains commas, this could confuse Anki during the import.. 

Running the Import 
Within the Decks window in Anki, hit the Import File button at the bottom of the 
screen, or go to Tools > Import, or press CTRL-I. 

Browse to and select the text file to import. The Import windows should then appear in 
Anki: 

 

At the top you can select the note type to use and where to add the generated notes. 
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You can see that Anki has detected that we're using semicolons to separate the fields. If 
this is wrong, you can click on this button to correct Anki. 

Based on the note type selected, you can then map the fields in the text file to the fields 
in that particular note type. Since the above image shows me importing to the Basic note 
type, field 3—which in my text file represents the atomic number—has nowhere to go, 
and defaults to becoming a Tag. In this example it would make sense to create a new 
elements note type with the appropriate fields and card layouts. 

Some Importing Tips 
∗  Watch out for notes with similar first fields. If there are multiple notes to be 

imported that have the same value in their first field, only the last one will be 
kept (by default)! You can change this by changing the “Update existing notes 
when first field matches” drop down on the Import page to “Import even if 
existing note has same first field.” 

∗  Tag imported items. To have a tag applied to every imported item, add the line 
“tags:firsttag secondtag thirdtag”, and so on, to the very beginning of the file. 

∗  Use UTF-8 encoding. If your text contains any accented or special characters, 
make sure the document is encoded in UTF-8.  

∗  Add comments using “#”. You can add comments to your text file by prefacing the 
line with a “#”. Any line that starts as such is ignored. 

∗  Take advantage of HTML styling. Anki can import HTML styling, such as 
<strong>this is bold</strong>. Just make sure you select the “Allow 
HTML in fields” checkbox during the import. Also, if your text content contains 
non-HTML <'s and >'s, you may run into some extraction problems. (This can 
be avoided by replacing non-HTML special characters with, for example, &lt; 
instead of < and &gt; instead of >. 

∗  Adding newlines. The easiest way to add new lines to imported notes is to use the 
HTML “break” tag: <br>. (Make sure you enable the “Allow HTML in fields” 
checkbox during import!) For example, the first line in the earlier example could 
be changed to: 
Hydrogen<br>(from the Greek 'hydro' and 'genes'); H; 1 
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Chapter 18 

Syncing with AnkiWeb 

At this point you’ve probably made a bunch of changes and additions to your Anki 
collection. From the Decks window, go ahead and click the sync button (or hit Y). 

Note: Every time you start up or shut down Anki it automatically syncs with 
AnkiWeb. This keeps your collection backed-up and always accessible from 
AnkiWeb. 

Assuming Anki doesn’t run into any problems, this should only take a second or two. If 
you have images and large media, it could take a bit longer. 

Log In to AnkiWeb 
Head over to https://ankiweb.net and log in with your AnkiWeb username and 
password. 

Here you should see a mirror of what is in Anki, with similar menu options and structure: 

 

You are essentially able to do everything online that you can do with the desktop 
software, though the online version is not as user-friendly.  
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Conflicts With Multiple Installations 
Let’s say you have Anki installed on your home computer and your work computer. If 
you reviewed a deck—call it “Presidents”—while at work, and didn’t sync or close Anki, 
then came home and did some more review on that deck, you would have to different 
records of reviewing the same deck.  

Anki handles these sorts of conflicts as best it can, but sometimes some review logs must 
be overwritten by other logs. With the release of Anki 2.0, there is much better handling 
of conflicts than before, but it can still be a problem. Sync your decks regularly, kids. 

To prevent these sorts of situations from happening, simply make a habit of closing Anki 
(or at least running a sync) after you have finished your reviewing. If you are only using 
Anki on a single device, this is something you should never have to worry about. 

Syncing Media 
As of Anki 2.0, all media is automatically synced with AnkiWeb, hassle-free. For the 
time being, there is no limit to the amount of data you can store on AnkiWeb. 
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Chapter 19 

The Secret to Speed: Keyboard 
Shortcuts 

This chapter is about a particular idea that is invaluable to getting the most from Anki 
and becoming a memorizing master: keyboard shortcuts. These are those little handy 
tricks whereby you hit some keys on your keyboard and magical things happen. (Well, 
actually it’s things you could have done with your mouse.) 

So what’s the big hoopla about keyboard shortcuts? One word: speed. Using Anki often 
involves a lot of clicking, editing, tweaking, moving, selecting, and so on—stuff that takes 
time. This isn’t bad; this is a testament to the power and flexibility of Anki. However, 
sometimes we just want to make a quick change here, a small edit there, a short review 
elsewhere, as quickly as possible. 

Here’s an example. When I’m reviewing a deck and I see a typo it bugs me and I want to 
fix it. But I’m also trying to cram in as many reviews as possible in my short ten-minute 
break. I don’t feel like editing card templates… I’ll just do it later, I tell myself. But with 
keyboard shortcuts, the instant I notice a problem with the particular card layout of the 
card I’m studying it’s as simple as: 

1. E (open note editor for this card) 
2. ⌘L (open card editor for card used by this note; CTRL-L on a Windows 

computer) 
3. [make quick change to layout, the preview of the current card shows that the 

change worked] 
4. ESC (close card editor) 
5. ESC (close note editor) 
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All in a grand total of five seconds. It’s not lightning speed, but it is fast and easy. When 
I’m studying my hands are on the keyboard ready to select the difficulty (1 to 4) of the 
answer, so a simple note edit is as easy as E > [make change] > ESC. 

The moral of the story is this: if you take the time to learn the keyboard shortcuts, as you 
need them, you will find them extremely useful. Your whole Anki experience will be much 
better off when you can whiz through editing and tweaking, rather than lumbering 
slowly. Almost everything in Anki can be done with keyboard shortcuts, so use them to 
your advantage! 

With that said, what follows are the most important keyboard shortcuts for various 
components and uses within Anki. There’s no need to read over these and memorize 
them. It’s enough to realize that they exist, and the next time you want to use one of 
them just hover your mouse over the desired function (e.g. the Cards… button in the 
note editor) and the mouse-over text that appears will tell you what the shortcut is for 
that function. 

Note that some of the following shortcuts show the OS X computer symbols. If you’re on 
Windows, just replace ⌘ with CTRL. 

The Most Important Keyboard Shortcuts 
These are the keyboard shortcuts I find most useful. There are many, many more, but 
here’s a start. 

Deck List 

∗  / – Produces a popup listing every deck in your collection, start typing to filter 
the list, and hit ENTER to start studying the selected deck. 

∗  A – Bring up the note editor to quickly start adding some notes. 
∗  B – Open the card browser. 

Note Editor 

∗  TAB – Move quickly between fields. 
∗  ⌘ + ENTER – Save and close the current note. 
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∗  ⌘ + SHIFT + C – Wrap the selected text in cloze deletion brackets. 
∗  ⌘ + D – Change the deck this note will be created in. 

Studying 

∗  SPACEBAR – Show the answer. 
∗  SPACEBAR – Record the suggested grading (difficulty) of the answer. 
∗  1, 2, 3, 4 – Record the difficulty of the answer. 
∗  E – Edit this card. 
∗  FUNCTION + DELETE (or DEL in Windows) – Delete this card. 
∗  R  – Replay audio. 

Again, just about everything you can possibly do in Anki has a keyboard shortcut. If you 
take the very small amount of time needed to learn them you will find using Anki quick 
and easy. 
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Chapter 20 

Beware These Common Beginner 
Problems 

At this point we should take a minute to review some common problems and roadblocks 
that beginners seem to run into. These are almost all problems I’ve experienced at one 
point or another. 

Biting Off More than You Can Chew 
It's easy to get caught up in the excitement of having a fantastic memory and download 
every shared deck you can get your hands on. Learn every country’s name, capital city, 
national anthem, average altitude, and gross domestic product! Learn four languages at 
once!  Expert spaced repetition users have claimed decks with many tens of thousands of 
cards, so why can’t you?  

Have patience. Start small, and add at a pace that works for you. 

Don't overcommit! Be realistic: planning to use Anki for an hour each and every day is 
not going to happen. For starters, I suggest doing no more than fifteen minutes a day, max. 

Don't clutter your learning process with useless information. Know what’s important and 
eliminate what’s not. 

Also, keep in mind that at the beginning the number of items to review may seem large. 
Stick with it and get over the initial hump! This number will decrease as time goes on, 
provided you stick to a review schedule. 
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Only Using Shared Decks 
Don't make the mistake of only learning from shared decks. Anki will help you thrive if 
you take the (relatively little) time to create your own memorable and relevant cards.  

Not Making It Personal 
Related to the above, Anki decks should be as personalized and self-relevant as possible. 
This is one of the biggest hazards with sharing decks: you don't make them yourself. 
When possible, customize decks—even shared ones from friends or from AnkiWeb—to 
make them more personally relevant and memorable. For your own decks, don’t just fill 
them with plain raw data for rote memorization, use anecdotes, examples, and personally 
relevant material. 

Not Customizing 
The basic card and note types that come with Anki are exactly that: basic. They are 
minimal working examples. Don't limit yourself to only the defaults. Play around with 
note fields and card templates to get the most from your learning experience.  

Too Much Customizing 
Not customizing, too much customizing . . . which is it?! Yes, Anki has a powerful ability 
to create custom note types and card layouts, but it’s possible to get carried away making 
complex cards or notes that are too fancy. Future changes or updates become complicated 
when you forget exactly how you had the card structured or what your fields were 
supposed to be used for. Creating new similar decks is a hassle because you have to tweak 
your layouts every time. 

Keep layouts and fields mostly generic, unless being very specific is absolutely necessary. 
Don't make a card type for a specific class from a specific semester from a specific year; 
make one for a semester, the entire year, or perhaps the topic in general. This makes 
them more flexible to change and more easily available for future use.  

Customization does help with creating unique and memorable cards, but you have to 
balance the tradeoffs and find the happy medium that works best for you. 
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Ignoring the 20 Rules 
This is a bit of a “catch all” category. Review the 20 rules from the earlier chapter every 
now and then (or better yet, make yourself a deck for them as practice). This will save you 
much time and frustration in the long run. 

* * * 
Running into your own problems, questions, or concerns? Let me know at 
contact@ankiessentials.com and I'll update this chapter in future editions of Anki 
Essentials. 
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A Collection of Other Possible Uses 
for Anki 

As I’m sure you’ve noticed by now, Anki is a very flexible program. The list of possible 
uses is endless. Here is a collection of just a few ideas of ways to use Anki that I have 
either already tried or would like to try. 

Meeting People Before Meeting Them 
I went to a rationality minicamp9 where everyone submitted a photo of himself or herself 
before arriving. The organizers made an Anki deck of everyone’s face and name with 
which to practice before arriving. Then, when everyone showed up, we all already knew 
each other’s names and faces without having ever talked or met—a very interesting 
experience. 

Mastering the Mnemonic Major System 
The mnemonic major system10 is a technique used to memorize numbers. This system 
works by converting numbers into different sounds, and vice versa. The following is a 
common number-to-sound breakdown (notice that no sound is used for more than one 
number): 

0. z, s, and soft c – These sound like the start of the word zero and sound similar to 
each other. 

1. d, t – These each have a single down stroke and sound similar. 
2. n – An n has two down strokes. 

                                                        

9 Check out http://appliedrationality.org.  
10 See http://en.wikipedia.org/wiki/Mnemonic_major_system. 
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3. m – An m has three down strokes. 
4. r – An r sounds like four. 
5. l – An L is the roman numeral for 50. 
6. j, soft “g” (also: sh, soft “ch”, dg, zh) –  
7. k (also: hard c, hard g, hard “ch”, q, qu) – A k looks like two sevens stuck together, 

the rest sound similar. 
8. f, v, th – A fancy f looks a bit like an eight; a v sounds similar to f. 
9. b, p – A b and p look like flipped and mirrored nines, respectively. 

Given these number-to-sound pairings, we can convert numbers into words! Note that 
none of the numbers equate to vowels or w, h, y, and x, because we are allowed to use 
these as “fillers” between consonants.  

For example, the number “21” can be converted to the word “net” by changing the 2 to an 
n and the 1 to a t, and then filling in an e. The word “net” is easy to visualize, so 
whenever you see the number 21 you can train yourself to instantly picture a net, and vice 
versa. If you do this with one hundred words for the numbers from zero to ninety-nine, 
you can develop and impressive ability to memorize any numbers, such as phone 
numbers, but instantly converting it to a series of visual images which are much easier to 
remember. 

Your different card layouts might look like this: 

∗  letter  associated sound(s) 
∗  sound  associated letter 
∗  number  word 
∗  word  number 

If you really wanted to pump this technique up on steroids, try what I did and hand-draw 
100 pictures for the numbers from 0 to 99 and use those in your cards. It took a lot longer 
to make, but it sure was effective. 
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Inspirations (a.k.a “Sh*t that gets me motivated!”) 
We’re all human. Our motivation ebbs and flows all over the place. Sometimes I’m ready 
to take on the world; sometimes I’m ready to sleep for a week straight. 

Sometimes I need some real inspiration to get me motivated, so I created a deck that 
simply lists things that inspire me: images, quotes, specific people, major events in world 
history, genuine long-term goals of mine, etc. Since I’m easily turned off by words like 
“inspirations” and “motivation”, I named my deck “Sh*t that gets me motivated!” When 
in need, I simply flip through 5–10 cards, dwelling on each for at least a few seconds. 
Works like a charm. 

* * * 
What other ideas can you think of? Get creative! And, of course, go ahead and try any of 
these or other ideas that intrigue you.   
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Expanding Anki with Add-ons 

Anki add-ons, a.k.a. plugins or extensions, are small programs written by Anki 
enthusiasts that add extra functionality and features to Anki. The types of features 
available range from adding graphic deletion capabilities to customizing the stroke colors 
of Kanji characters. 

My personal Anki usage hasn’t required many add-ons, so I don’t have much to say about 
them. However, these are a few add-ons that I have found useful. Explore the Anki add-
ons page at https://ankiweb.net/shared/addons/ for a complete list. Note that add-ons are 
programs written by anybody and are potentially malicious, so you should only download 
add-ons that you trust; I generally favor add-ons with four or more stars and multiple 
reviews. 

Add-on: More Overview 
Stats 
https://ankiweb.net/shared/info/21161308
37  

This add-on adds a more info to the 
overview statistics page for your decks. 
Specifically, it adds the number of total 
reviews, total new cards (not just today’s 
limit), and total cards. 
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Add-on: Image Occlusion 2.0 
https://ankiweb.net/shared/info/282798835  

Image Occlusion 2.0 is a fantastic add-on for creating graphic deletion cards. Just like 
cloze deletion, which omits portions of text, graphic deletion omits parts of an image. 
Normally this requires creating a bunch of separate images with omitted portions, which 
can be a time-consuming and annoying task. Image Occlusion 2.0 makes this easy. You’ll 
have to check out the documentation at http://tmbb.github.com/ImageOcc2.0/ to get the 
hang of using it. 

How to Install Add-ons 
To download a specific add-on, copy the number provided on the add-on’s page (e.g. 
“282798835” for Image Occlusion 2.0). Then in Anki go to Tools > Add-ons > Browse 
& Install and paste the number into the Code box and hit OK. (You may be prompted to 
restart Anki before the add-on is available.) 

 

Keep in mind that with every additional add-on you increase the chances of a problem 
from add-on conflicts or buggy code, so limit yourself to the ones you really need. 
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Creating Multiple User Profiles 

Some of you may be sharing a computer. If there is more than one person using Anki on 
a given system, this can be done by creating separate profiles.  

By default, Anki is configured with a single profile, created when you first install and log 
in with your AnkiWeb credentials. To add additional profiles and modify existing ones, 
you must open the Profiles window. 

From the Anki toolbar go to File > Switch Profile (SHIFT-CTRL-P or ⌘P). This opens 
the Profiles window. 

While we’re here, feel free to rename your own profile if you wish. 

To add a new profile, click the Add button, enter the desired name, and click OK. Then 
click Open to open up this collection.  

Just as when you open or close Anki, every time you switch between profiles your 
collection is automatically synced with AnkiWeb. 

As you can see, a blank collection was created, ready for this user. To connect this new 
profile with AnkiWeb, hit the Sync button (or press Y) and you will be prompted to enter 
the account information, just as in chapter 2. 

The number of profiles allowed in Anki is limitless. It is not suggested to use multiple 
profiles to separate or group your decks into different collections. This makes it difficult 
to move cards and decks around within your collections, and requires you to have 
multiple accounts configured on AnkiWeb, an unnecessary hassle. 
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A Quick Overview of Anki’s Settings 
and Preferences 

The Anki software comes with some program-wide settings, all of which are configured 
through Anki > Preferences (on OSX) or File > Preferences (on Windows). You can see a 
detailed discussion of these at http://ankisrs.net/docs/dev/manual.html#profileprefs. 
Here, I want to highlight a few items. If you change any settings be sure to restart Anki 
to ensure they take effect. 

Basic Preferences 
I keep Strip HTML when 
pasting text checked, 
otherwise I run into 
problems pasting text from 
websites or documents with 
underlying styling that gets 
copied into my note and is a 
pain to remove afterwards. I 
also keep Paste clipboard 
images as PNG checked; this 
results in larger file sizes, 
but I think it’s worth the 
lossless image format and 
transparency. 

Timeboxing, which is set to 
zero (disabled) by default, is 
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a useful features that shows you how may cards you’ve studied so far in, for example, ten 
minute time windows. I have this set to ten minutes to periodically break up my studying 
with a progress update. 

Network 
These are the settings related to syncing your collection with AnkiWeb. Both 
synchronization settings are on by default and I suggest you keep it that way. You can 
also deauthorize the current User account, if desired. 

Backups 
By default Anki keeps 30 backups of your material, but does not back up media (except 
for the latest media which is backed up on AnkiWeb). I keep at least several backups of 
my Anki collection in my Dropbox folder. 
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Keeping it All Clean and Tidy 

Now that we're nearly finished with this guide, I want to leave you with a few sage words 
of advice: 

Keep your collection clean and tidy! 

We've just about covered all the important aspects of using Anki, but there's at least one 
more area to cover: maintenance.  

Anki decks can grow very large over time—sometimes to the point of becoming 
“bloated.” Regular maintenance is a must for the longevity of your collection and study 
habits. 

Periodically Review Everything 
Periodically—such as once a month—I highly recommend doing a quick review and 
cleanup of your entire Anki collection. My process tends to look like this: 

1. Open the Anki card browser. 
2. Review all of the decks in my collection. Lean towards simplifying and eliminating 

everything in your collection: 
a. Is this still important? Is this worth spending my time and mental energy? – 

Let’s face it: I’m not spending hours a day using Anki. So, what are my 
priorities? Am I wasting time on decks that aren’t very useful? That goal 
to learn all the countries and cities in the world? Maybe put it off for 
now.  

b. Is this up-to-date? – Have things changed? Do I need to add or remove 
any notes? Are there any outdated notes I can delete? There’s no sense in 
memorizing material that is out-of-date or, even worse, wrong. 
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3. Review all Marked, Suspended, and Leech notes. Figure out what the problem was 
and either: 

a. Fix it; or, 
b. Delete it. 

4. Run all of the Anki Maintenance options (detailed below).  
5. Run a full sync with AnkiWeb. 

Anki Collection Maintenance 
Anki also comes with several useful maintenance tools that you should regularly take 
advantage of. 

Maintenance > Check Database… 
During a collection cleanup, go to Tools > Maintenance > Check Database. Anki will run 
a set of tests and checks to ensure that everything is fine and dandy in your database. If all 
goes well you should see a message like this: 

 

If not, you will have to address whatever issue Anki detects. 

Maintenance > Unused Media… 
If you go to Tools > Maintenance > Unused Media…, Anki will generate a list of all 
media items contained in your library that are not being used by any of your notes: 
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Give this list a quick review and, if you’re satisfied that those files are no longer needed, 
hit Delete Unused. 

Maintenance > Empty Cards… 
Anki is also able to check for any empty cards in your collection by going to Tools > 
Maintenance > Empty Cards…. If all is well you’ll see a message like this: 

 

If not you may need to address whatever empty cards Anki finds. 
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Conclusion 

Phew! It's been a long ride, but we're finally at the end. What now? What next?  

By now you should understand how Anki works—from the big picture to the nitty gritty. 
We’ve covered creating note types, note fields, and notes themselves; cards and card 
templates; studying and cramming; specific applications that you can try out right away; 
and much more. 

If anything, I hope this guide has encouraged you to give Anki a serious try. I hope you 
enjoy harnessing the power of Anki and spaced repetition software. I know you can 
become a true Anki master. 

I've been using Anki for over a year, and I'm still coming up with new and fun ways to 
get a lot of use out of it. It is one of my most valuable remembering and internalizing 
tools in my arsenal. (In case you’re wondering, the other biggie is mind mapping.) 

This entire guide will be for naught if you don’t go out and give Anki a try. Have some 
fun with it! Try learning and memorizing that thing you’ve always wanted to memorize. 
Impress your friends at school or you boss at work. Crush those entrance exams. Rock 
your courses. Master piano theory. Internalize all that basic material you’ve been putting 
off. Try coming up with new and clever uses of Anki. The options are endless. 

Most important of all, have fun with it; no tool you dislike using will last. Also 
remember: don’t overwhelm yourself. New Anki users are wont to create hundreds and 
hundreds of cards in their first week, only to be overwhelmed by how much they have to 
study! Take it slow, prioritize what’s important, and have fun! 

And last but not least, don’t forget to take a look at the last chapter in this book for a 
bunch of additional useful resources and links. 
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About the Author 

Hi, I’m Alex. I enjoy personal development, learning cool stuff, hanging out with cool 
people, and trying to have a positive impact on the world.  

I first stumbled on Anki while researching better ways to remember and internalize the 
vast quantities of information I was trying to remember. In general, I love reading and 
learning about just about anything, though I tend to focus on cognitive psychology, 
neuroscience, rationality, and philosophy. I do a diverse array of freelancing jobs from 
web development and copyediting to eBook formatting and research writing. 

As of this writing I split my time between the following: 

→  http://alexvermeer.com – This is my personal blog. I write about what I’m 
currently reading and researching, when I can find the time. I mostly research 
ways to improve my thinking and decision-making skills, low-hanging 
productivity and organization hacks, and general self-improvement. Currently 
my most popular work is an anti-procrastination poster, available for free at 
http://alexvermeer.com/getmotivated/.  

→  http://intelligence.org – I work remotely for the Machine Intelligence Research 
Institute, a non-profit research group trying to ensure that things turn out right 
for us human when machine intelligence surpasses human intelligence. 

→  http://universityboulderingseries.ca – I’m addicted to bouldering (rock climbing 
sub-twenty-feet without rope), and I’m part of a team creating a University-based 
bouldering competition in Canada. 

Feel free to get in touch with me for any reason by shooting an email to 
alex@alexvermeer.com.  

–Alex 
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Please consider supporting the author so that Anki can continue to improve. 

Please consider donating to Damien Elms and supporting Anki at 
http://ankisrs.net/support/. (This is not a self-endorsement. I receive none of this money. 
Your entire donation goes to supporting Damien in the ongoing development and 
support of Anki.) 



Additional Resources – Anki Essentials 116 

Chapter 29 

Additional Resources 

With over a hundred pages in this book we’ve covered a lot of ground. Despite this, you 
may still have questions or issues when using Anki, or question and curiosities about 
spaced repetition software and memory. Where else can you go for more information? 

Further Reading 
There are numerous great posts around the internet with lots of good information on 
spaced repetition, memory, and learning in general. Here are a few I enjoy: 

∗  Spaced Repetition. http://www.gwern.net/Spaced%20repetition An excellent article 
by Gwern (http://www.gwern.net). I already mentioned this one at the start of 
the book but it’s worth mentioning again. This is far an away the best, most in-
depth article on the topic. A must read for anyone interested in knowing why 
spaced repetition works so well. 

∗  Want to Remember Everything You’ll Ever Learn? Surrender to This Algorithm. 
http://www.wired.com/medtech/health/magazine/16-05/ff_wozniak A Wired 
article by Gary Wolf. 

∗  QS Primer: Spaced Repetition and Learning. 
http://quantifiedself.com/2012/06/spaced-repetition-and-learning/ An article 
from Quantified Self that’s jam-packed with useful and cool information. 

∗  Memorizing a programming language using spaced repetition. https://sivers.org/srs 
An article written by Derek Sivers, who calls spaced repetition “the most helpful 
learning technique I’ve found in 14 years of computer programming.” 

∗  Janki Method. http://www.jackkinsella.ie/2011/12/05/janki-method.html An 
article written by Jack Kinsells about Janki Method. The goal is to “achieve 
proficiency in a given field of programming . . . in less than 12 months.” 
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∗  The 20 rules of formulating knowledge in learning. 
http://www.supermemo.com/articles/20rules.htm I wrote my own summary of 
these rules earlier in the book, but I still highly recommend reading the original 
classic by Piotr Wozniak. 

∗  Memory and Learning: Myths and Facts. 
http://www.supermemo.com/articles/myths.htm Another great article from Piotr 
Wozniak. I love this guy! 

∗  The roots of creativity and genius. http://www.supermemo.com/articles/genius.htm 
An attempt by Piotr Wozniak at “formulating a prescription for genius and 
creativity.” A long but interesting read. 

Anki Essentials Resources Page 
For starters, I set up a resources page on the Anki Essentials homepage at 
http://alexvermeer.com/anki-essentials/resources/. Here you will find links to much of 
the content linked in this book. (The internet has a funny way killing off links left, right, 
and center; this way I can update the links on the resources page without having to 
update the book every time one changes.) 

Official Anki Support and Documentation 
Anki has a several official resource pages, as well as two official forums (links can be 
found at http://alexvermeer.com/anki-essentials/resources/): 

→  The official “Getting Help” Page – Damien has a “Getting Help” page at 
http://ankisrs.net/docs/help.html to help direct people to various resources.   

→  Anki Help Google Group – A group for posting general help requests and bugs. 
Make sure you search through the forum history and read through the Anki 
FAQ before posting your questions! 

→  Anki Users Google Group – A group for discussing learning techniques, hearing 
about the latest Anki updates, and other general announcements.  

→  Anki FAQ – A collection of frequently asked questions about using Anki. 
→  The official Anki 2.0 User Manual, written by Damien Elms himself. 
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Anki Essentials Support 
For questions specific to this book, please feel free to contact me at 
contact@ankiessentials.com or at http://alexvermeer.com/anki-essentials/contact/. 
General help should be directed to the Anki forums, where others may have already 
solved your problem, and where others will benefit from you getting a solution. 

Contributing to Anki’s Code 
If you’re a bit of the code-monkey type and want to see the inner workings of Anki—and 
possibly contribute some code changes or bug fixes—you can find Anki’s source code at 
http://github.com/dae. Be sure to take a look at the License file, and if you agree to the 
license, drop Damien an email or a Github pull request—http://ichi2.net/contact.html.  


